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Safety Information (Multi-Language)

Safety Precautions

The following safety information includes instructions about avoiding personal injury,
before and while servicing the Color Controller C-80.

General Safety

Follow these rules to ensure general safety:

Lift up the Color Controller C-80 using the handle and not using the front panel.
Lifting it up using the front panel may result in major injury.

Before opening the Color Controller C-80 covers, ensure that the unit has been
switched off.

Pressing the ON/OFF power button will leave some circuits energized. For
complete disconnection from the supply, the main power cable must also be
disconnected from the power source.

Battery Replacement

Static Electricity

Only qualified service personnel should replace the battery.

Handle and dispose of the used batteries according to Lithium battery
manufacturer’s instructions.

When handling static-sensitive electrical devices (such as: electronic boards, disk
drives, or memory modules):

Use a field service grounding kit (chain, mat, and wrist strap).

After removing the component from the system or from its protective wrapper,
place it on a grounded anti-static mat and not on a carpet, or on any other
unshielded surface.

After removing a board from a station, store it in an anti-static bag.
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Vii

SicherheitsmaRnahmen

Die folgenden Abschnitte enthalten Sicherheitsinformationen zur Vermeidung von
personlichen Verletzungen vor und wahrend der Wartung des Color Controller C-80.

Allgemeine Sicherheit

Befolgen Sie diese Regeln, um allgemeine Sicherheit zu gewahrleisten:

Batterieaustausch

Reibungselektrizitat

Heben Sie den Color Controller C-80 nur am Griff hoch und beriihren Sie nicht
die Frontblende. Wenn Sie ihn an der Vorderblende hochheben, kann dies zu
schweren Verletzungen fihren.

Bevor Sie die Schutzabdeckung des Color Controller C-806ffnen, stellen Sie
sicher, dass die Einheit ausgeschaltet wurde.

Wenn Sie das Gerat nur mit der ON/OFF-Schalttaste ausschalten, bleiben
einige Stromkreise aktiviert. Um eine vollstandige Trennung von der
Stromversorgung zu erreichen, muss der Hauptlastschalter von der Stromquelle
getrennt sein.

Die Batterie sollte nur von qualifiziertem Kundendienstpersonal ausgetauscht
werden.

Handhaben und entsorgen Sie die verbrauchten Batterien entsprechend den
Anweisungen des Lithiumbatterie-Herstellers.

Beim Umgang mit statik-empfindlichen elektrischen Geraten (wie z.B.: elektronische
Karten, Plattenlaufwerke oder Speichermodule):

Benutzen Sie einen Erdungsmontagesatz fiir den Auf3endienst (Kette, Matte
und Manschetten).

Nach dem Entfernen des Teils aus dem System oder aus seiner Schutzhiille
stellen Sie es auf eine geerdete anti-statische Matte und nicht auf einen Teppich
oder auf andere ungeschutzte Oberflachen.

Nachdem Sie die Steckkarte aus einer Station entfernt haben, bewahren Sie sie
in einer anti-statischen Tlte auf.
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Medidas Preventivas de Seguridad

Las secciones a continuacion contienen informacion de seguridad para evitar
lesiones, antes y durante la prestacion de servicio de mantenimiento y reparaciones
del Color Controller C-80.

Seguridad General

Siga las siguientes reglas para garantizar la seguridad general:

* Levante el Color Controller C-80 utilizando el mango y no el panel frontal. Al
levantarlo utilizando el panel frontal se pueden ocasionar serias lesiones.

* Antes de abrir las cubiertas del Color Controller C-80, asegurese de que la
unidad ha sido apagada.
Si se apaga utilizando el botén ON/OFF solamente, algunos circuitos
permanecen activados. Para una desconexiéon completa del suministro de
energia, el cable de alimentacion principal se debe desconectar de la fuente de
alimentacion.

Sustitucion de la bateria
¢ Soélo un ingeniero de mantenimiento y reparaciones debe reemplazar la bateria.

* Manipule y deshagase de las baterias usadas de acuerdo a las instrucciones
del fabricante de la bateria de litio.

Electricidad estatica

Cuando se manejan dispositivos eléctricos sensibles a electricidad estatica (como
por ejemplo: placas electrénicas, unidades de disco, o0 médulos de memoria):

* Use un kit de puesta a tierra para reparaciones y mantenimiento en terreno
(cadena, felpudo y banda de muiieca).

* Después de sacar el componente del sistema o de su lugar de envoltura de
proteccién, coléquelo en un felpudo antiestatico puesto a tierra y no en una
alfombra o cualquier otra superficie no protegida.

¢ Después de sacar una placa de una estacion, almacénela en una bolsa
antiestatica.
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Mesures de sécurité

Les sections suivantes contiennent des informations sur les mesures de sécurité a
prendre pour éviter les blessures personnelles, avant et pendant I'entretien du Color
Controller C-80.

Mesures générales de sécurité

Suivez ces régles pour garantir une sécurité générale :

Soulevez le Color Controller C-80 par la poignée et non par le panneau frontal.
L'utilisation du panneau frontal pour soulever le dispositif peut entrainer des
blessures graves.

Avant d'ouvrir les couvercles du Color Controller C-80 vérifiez que I'unité a été
éteinte.

Si vous ne mettez hors tension que l'interrupteur ON/OFF, certains circuits
resteront sous tension. Pour une déconnexion totale de I'alimentation en
courant, le cable d'alimentation principale doit aussi étre déconnecté du bloc
d'alimentation.

Remplacement de la batterie

Electricité statique

Le remplacement de la batterie est une opération réservée au personnel de
service qualifié.

Manipulez et jetez les batteries utilisées selon les instructions du fabriquant de
batterie au Lithium.

Lors de la manipulation des périphériques électriques sensibles a I'énergie statique
(tels que : les cartes électroniques, les lecteurs de disque ou les barrettes de
mémoire) :

Utilisez une trousse de mise a terre (une chaine, une carpette et un bracelet
anti-statique).

Aprés avoir enlevé le composant du systéme ou de son emballage de
protection, placez-le sur une carpette anti-statique mise a la terre et non sur une
carpette ou sur n'importe quelle autre surface non protégée.

Aprés I'enlevement d'une carte d'un poste, conservez-la dans un emballage
anti-statique.
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Precauzioni di Sicurezza

Le seguenti sezioni contengono informazioni di sicurezza riguardanti I'evitamento di
lesioni personali, prima e durante I'uso del Color Controller C-80.

Sicurezza generale

Seguite queste istruzioni per assicurare la sicurezza generale:

Alzate il Color Controller C-80 usando la maniglia e non usando il panello
frontale. Alzandolo usando il panello frontale potrebbe causare una grave
lesione.

Prima di aprire la copertura del Color Controller C-80, assicuratevi che I'unita sia
stata spenta.

Spegnendo I'unita, solo il pulsante ON/OFF lasciera qualche circuito alimentato.
Per arrivare a una sconnessione completa dalle fonti di alimentazione, il cavo di
alimentazione principale deve essere staccato dal connettore di alimentazione.

Sostituzione della Batteria

Elettricita Statica

La batteria dovrebbe essere cambiata solo dal personale di assistenza
qualificato.

Disfatevi delle batterie usate a seconda delle istruzioni del fabbricante
riguardanti batterie Lithium.

Quando gestite dispositivi di sensitivita elettro-statica (come: schede elettroniche,
dischi rigidi o moduli di memoria):

Usate un campo di servizio di attrezzatura messa a terra (catena, stuoia, cinghia
da polso).

Dopo avere rimosso il componente dal sistema o dal cartoccio protettivo,
mettetela su una stuoia anti-statica a terra e non su un tappeto o ogni altra
superficie non protetta.

Dopo avere rimosso una scheda dalla stazione, custoditela in una borsa anti-
statica.



Veiligheidsmaatregelen Xi

Veiligheidsmaatregelen

In de volgende secties worden veiligheidsmaatregelen behandeld om persoonlijk
letselt voor en tijdens het bedienen van de Color Controller C-80 te voorkomen.

Algemene veiligheid

Volg onderstaande regels op om uw algemene veiligheid te verzekeren:

* Gebruik het handvat om de Color Controller C-80 op te tillen, en niet het
voorpaneel. Wanneer u het voorpaneel gebruikt bij het optillen kan dit resulteren
in ernstig letsel.

* Zorg ervoor dat de Color Controller C-80 is uitgeschakeld voordat u de deksels
opent.
Wanneer u alleen de ON/OFF schakelaar uitschakeld zullen bepaalde
electriciteitscircuits geactiveerd blijven. Om de stroomtoevoer volledig af te
sluiten moet de electriciteitskabel uit het stopkontact zijn.

De batterij vervangen

* De batterij mag alleen door bevoegd servicepersoneel worden vervangen.

* Volg de instructies van de fabrikant op voor het vervangen en het wegwerpen
van gebruikte lithium batterijen.

Statische electriciteit

Wanneer u met electrisch statisch geladen onderdelen omgaat (zoals: electronische
kaarten, harde schijven of geheugenmodi):

* Gebruik een onderhoudsaardingpakket (ketting, mat, en een polsbandje).

* Nadat u het onderdeel van het systeem verwijderd of uit zijn beschermend
omhulsel neemt, plaatst u dit op een geaarde anti-statische mat en niet op een
vloerkleed of enig andere onbeschermde oppervlakte.

* Nadat u een kaart van een station heeft verwijderd plaatst u deze in een anti-
statisch zak.
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Precaucgoes de seguranca

As seguintes sessbes contém informagdes de seguranga com respeito a como
evitar feridas corporais, antes e no decorrer do uso do Color Controller C-80.

Seguranca geral

Siga as seguintes regras para assegurar uma seguranca geral:

Troca de bateria

Eletricidade estatica

Levante o Color Controller C-80 usando o cabo e ndo o painel frontal. Ao
levanta-lo através do painel frontal pode causar sérios danos.

Antes de abrir as tampas do Color Controller C-80, certifique-se de que a
unidade foi desligada.

Ao desligar somente com o botdo ON/OFF fara com que alguns circuitos sejam
ativados. Para uma desconexido completa da fonte de alimentagao, o cabo de
alimentagao principal também deve ser desconectado da fonte de alimentagao.

A bateria deve ser substituida somente por uma equipe de servigo qualificada.

Manipule e jogue fora as baterias usadas de acordo com as instrugdes do
fabricante de baterias de Litio.

Ao lidar com dispositivos sensiveis a energia estatica (como: placas eletrbnicas,
unidades de disco ou médulos de memdria):

Utilize um kit de aterramento de servigo (cadeia, esteira e faixa de pulso).

Apods a remocgao do componente do sistema ou do seu invélucro de protecao,
coloque-o em uma esteira anti-estatica e ndo em um tapete ou qualquer outra
superficie desprotegida.

Apds remover uma placa de uma estagao, armazene-a em uma bolsa anti-
estatica.



Product Overview

[} (0o [UT03 (o] o AT

Product Configuration..............eeei i



Chapter 1—Product Overview

1.1

Introduction

The Color Controller C-80, Powered by Creo Color Server Technology is an
on-demand printing system that uses advanced printing technologies to drive the
press and turn it into a fast, high-quality network printer. It is a digital color solution
for printers that enables you to print from computers running the Microsoft®
Windows®, Apple Mac OS, or UNIX® operating systems. It can output high-value
products, such as flyers, brochures, pamphlets, catalogs, and Variable Data Printing
(VDP) publications.

The Color Controller C-80 processes files in PDL (for example, PostScript®, PDF,
and VDP) formats—converting them into a suitable ready-to-print format for direct,
high-quality printing.

The Color Controller C-80 combines raster image processing (RIP) competencies,
quality-enhancement tools, automation and control tools, and special hardware
capabilities.

1.1.1 Color Controller C-80 Components

The Color Controller C-80 is a dedicated platform running in the Microsoft Windows
XP Professional operating system. There are four main groups of components:

* Dedicated hardware

¢ Off-the-shelf hardware

* DVD-RW drive

* Software including:
0 Windows XP Professional for embedded solutions
0 Adobe® Acrobat® 9.0

3 Color Controller C-80 software version 1.0



1.1.2 Functionality and Features

The features and functions of the Color Controller C-80 include:

Efficient variable information printing

Enhanced job-editing capabilities

Image-enhancement capabilities

Color management tools

Enhanced text and line-art quality

Post-RIP imposition

Job management

On-screen preview and editing

Print jobs at machine-rated speed

RIP—Adobe Postscript Level 3 and Extreme certified technologies
Ready-to-print job format for immediate reprint
Extensibility—scalable, modular, and with multiple upgrade paths

Gallop printing while you RIPing process

1.1.3 Supported Client Platforms

The system is capable of receiving and processing input from a variety of client
platforms:

Macintosh®
Windows
UNIX
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1.1.4 Product Configuration

Figure 1 shows the modular system architecture of the control station.

Peripherals Moritor
% Keyboard
¥ ¥
OnBoard Devices
=g Core2 Duad 2 66GHz, 1332MHz FSB | —=| FusionRA || Empty Sloté PCHI
[ v ] = L2=6ME | 2 x 1024ME Memory DDR2 pdi Bus
i} = Empty Slots PCIE x4
=B SATAY SATAZ SATAL
pual Ports ]
Er SATAT —| Ernpty Slotd PCLI3MHz
LAMN1 [ W @
sternal network
]
LAN2
To Printer

System disk fl Image
250G8 230G8
SATAZ SATAZ

Parts Description
A) System/user partitioned disk:
* 250GB hard disk
* Windows XP Professional loaded (on C:\)

¢ Default Windows-based computer and Macintosh shared folder,
including various utilities and PPD (on D:\)

¢ Default path for APR high-resolution files is D:\
* Spool area on hard disk containing the PostScript files
¢ Other data used for Color Controller C-80 software(on D:\)
B) FusionRA Board:
¢ Data decompression

* Page assembly

* FusionRA board supports color separations



C) Three image disks:
* 250 GB each

* After processing (RIPing), rasterized jobs are sent to (and stored on) the
image disks as RTP jobs

* Jobs stored on the image disks are changed or deleted via the Color
Controller C-80 software

D) Gigabit ethernet connection:

* Enables high-speed connection to the network

1.1.5 Disk Configuration

The following table outlines the Color Controller C-80 disk configuration.

Disk 0 C: D:

Windows XP Professional Spool files

Color Controller C-80 software| Shared files

Output directory files

Automatic Picture
Replacement (APR)
high-resolution files

Backup folder

Disk 1 Image storage

Disk 2 Image storage

Disk 3 Image storage
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2.1 Connecting the Color Controller C-80

For more information, see the Easy Setup Steps chart supplied with your
Color Controller C-80.

Connect the Color Controller C-80 to your printer as illustrated in Figure 2, below.

Professional Power Kit

Figure 2: Connecting the Color Controller C-80

2.1.1 Connecting the Color Controller C-80 to the Printer

To enable communication between the printer and the Color Controller C-80, you
need to enter the SP mode on the printer, and then select the correct SP5193-001
settings.

1.
2
3.
4

5.
6.

On the printer display panel, press Clear Modes.
Type 107, and press C (Clear) until the SP mode appears.
Touch System Sp.

Use the buttons on the touch screen to navigate to the SP5193-001 setting
(External Controller Info. Settings).

Type 5, and then press the # (Enter) key.

Touch Exit when the message to reboot the printer appears.

Note: During the process of connecting the Color Controller C-80 to the printer, you will
need to turn the printer off and then turn it back on.

7.

Turn off the printer using the main power switch that is located behind the front
cover.



10.

11.

Shut down the Color Controller C-80.

Locate the printer interface cable (crossover Ethernet cable) that was shipped
with the Color Controller C-80 and connect one end of the cable to the printer
interface port on the Color Controller C-80, and then connect the other end of the
cable to the correct Ethernet port on the printer.

=
(]

Figure 3: Printer and Color Controller C-80 connection

Note: To prevent the risk of crosstalk, make sure the printer interface cable does not
touch the system’s power cables. The Color Controller C-80 could shut down or image
quality problems could result.

Open the Color Controller C-80 front panel and press the power control button.

Wait approximately two minutes for the Color Controller C-80 to reach the idle state
and for the workspace to appear.

Turn on the printer using the main power switch.
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2.1.2 External LEDs and Controls

Front door closed

Figure 4 shows the external LEDs and controls of your Color Controller C-80.

DVD-RW drive

USB ports

Power control button
Power-on LED (green)
Reset button

___________ Disk activity LED (orange)
Not in use

Network activity LED (green)
............ Network activity LED (green)

Not in use

Front door open

Figure 4: Front door controls and indicators

Power control button Turns the Color Controller C-80 on or off

Power-on LED llluminates steady green when the Color
Controller C-80 is turned on
Reset button Restarts the Color Controller C-80

Disk activity (hard disk) Blinks orange when a hard disk drive is in use
LED

Network activity LED Blinks green when the network is in use

2.1.3 Turning On the Color Controller C-80

Before connecting the Color Controller C-80 to an AC power source, review Safety
Information (Multi-Language) on page v.
To turn on the Color Controller C-80:

1. Connect the monitor's AC power cable to the AC mains supply and turn on the
monitor.

2. Connect the server’'s AC power cable to the AC mains supply.

3. Wait 20 seconds before pressing the power control button on the Color
Controller C-80 (see Figure 4 on page 10). The ON/OFF LED on the front panel
illuminates a steady green.

After the system startup is complete, the Windows desktop appears.
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4. If a power failure occurs while the server is turned on, the server will restart
automatically when power is restored.

To turn off the Color Controller C-80:

Perform an orderly shutdown of the operating system before turning off the server.

1. Press the power control button to turn off the server.

2. Disconnect the AC power cable from the AC mains supply.

WARNING: Pressing off only the power control button will leave some
A circuits energized. For complete disconnection from the supply, the main AC
power cable must also be disconnected from the AC mains power.

2.2 Configuration Wizard (First-time Software Setup)

After turning on the Color Controller C-80 for the first time the Configuration Wizard
appears.

The first-time software setup is performed using the Configuration Wizard.

Note: During the configuration process, when prompted to restart your computer,
click No. At the end of the Configuration Wizard, you will be prompted to restart
your system.

2.21 Choosing the Configuration Type

< Configuration Wizard @

Configuration Type

Chose the way to canfigure the system:

Select First Time Configuration in order to set local system
parameters for the first time.

Select DFE configuration recovery to try and recover
system configuration from backup,

\# First Time Configuration

|_J DFE Configuration Recovery

Mext = Cancel

> Verify that First Time Configuration is selected, and click Next.
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2.2.2 Configuring the Server Setup

Server name
SRR SR Host name: POSQA-RAWIDTW Change. ..
Date & time
Date: Mar 25, 2009
Time: 10:33:21 change. .
< Back Next = Cancel

Configuring the Host Name

The initial computer name (host name) of the Color Controller C-80 is created
automatically during the factory installation. To change the computer name, check
with your system administrator.

1. In the Server name area, verify that the correct host name appears. If the name
is correct, proceed to Setting the Date and Time on page 13.

2. If you need to change the host name, click Change.

System Properties E| PZ|

System Restore Automatic Updates Femote
General Camputer Hame | Hardware Advanced
- Windows uses the following information to identify your computer
"f on the network.

Computer description: POSHW-S

For example: "Kitchen Computer or "Mary's

Computer'’,
Full computer name: POSHW-S.
workgroup: WORKGROUP
To use the Metwark |dentification Wizard ta join a -
domain and create a local user account, click MNetwork NEZAD

ID.

To rename thiz computer or join a domain, click Change.

@ Changes will take effect after you restart this computer.

QK ][ Cancel ][ Apply
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3. Inthe Computer name box, type the new name for the Color Controller C-80. If
you want to change the workgroup or the domain in which your computer
appears, type the new name in the corresponding box and click OK.

Attention: Do not modify the Workgroup or Domain in the following step unless
instructed to. If you do change the workgroup or domain, verify that you have the
correct user name and password for the workgroup or domain.

A message appears to inform you that changes will take effect only after
restarting the Color Controller C-80.

Computer Name Changes E| g|

*f'ou can change the name and the membership of thiz
computer. Changes may affect access to network, resources.

LComputer name:
POSHw-5|

Full computer name:
POSHW-S.

More...

Member of
O Domain:

& Workgroup:
WwORKGROUP

[ Ok H Cancel ]

4. In the System Properties dialog box, click OK.
Note: When prompted to restart your Color Controller C-80, click No.

Setting the Date and Time

1. Inthe Date & Time tab, verify that the date and time are set correctly. If they are
correct, proceed to Configuring the Network Setup on page 14.

Date and Time Properties

Date & Time ]Time Zone ] Internet Time ]

Date Time

1 2 3 4 5 6 7 . T,
8 9 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25 26 27 28
2o 30 8

846 14AM
Current time zone: Central Standard Time

Ok | Cancel | |

2. If you want to change the date and time, set the correct date and time, and then
select the Time Zone tab.
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Date and Time Properties

Date & Time  Time Zone | Internet Time

Iv automatically adjust clock For davlight saving changes

Ok | Cancel | |

3. Select the time zone in which you are located and click OK.

2.2.3 Configuring the Network Setup

ipuration Wizard

TCPIP

IP address: 150,248,235, 138
Subnet mask: 255,255, 255.0
Default gateway: 150,248.235.1
Preferred DS server: 10,4212

Alternate DS server: 10,4.2,100 Change...

TP

AppleTall setup

AppleTalk zone: Mo Zane Change. ..

< Back Mext = Cancel

Configuring TCP/IP Addresses

1. In the TCPIIP area, verify that the IP address is correct. If it is correct, proceed
to Configuring the IPv6 Address on page 15. If the IP address is not correct,
click Change.

The Local Area Connection Properties dialog box appears, followed by the
Internet Protocol (TCP/IP) Properties dialog box.



-L- Local Area Connection Properties

General | Advanced
Connect using:

| B8 IntellR] PRO/A000 PR Metwork Conr

Thiz connection uzes the following items:

S AppleT alk Protocal A
5 NetBEUI Protocal
L3 |ntemet Protocol [TCRAP] |
v {
|£ ¥
[rescription

Transmission Control Protocal/lntemet Protocal. The default
wide area network. protocol that provides communication
across diverse interconnected networks.

[] Show icon in notification area when connected
Motify me when thiz connection has limited or no connectivity

Internet Protocol (TCP/IP) Properties

General | Altemate Configuration

You can get IP settings assigned automatically if your network supports
this capability. Othenwise, you need to ask your netwark. administrator for
the appiopriate IF settings.

®i

() Uze the following |P address:

an P adarees automaticaly

(=) Obtain DNS server addiess automatically
() Use the following DNS server addresses:

2. In the Internet Protocol (TCP/IP) Properties dialog box, select Use the
following IP address.

3. Intheir corresponding boxes, type the new IP address, Subnet mask, and
Default gateway (if applicable).

4. Click OK.

Note: When prompted to restart your Color Controller C-80, click No. You
will be prompted at the end of the Configuration Wizard to restart the server.

5. Inthe Local Area Connection Properties dialog box, click OK.

Configuring the IPv6 Address
1. In the IPv6 Address area, verify that the address is correct.

2. Ifitis correct, proceed to Configuring the AppleTalk Zone.
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If the settings are not correct, select the IPv6 check box to enable IPv6
addressing.

The following message appears:

You need to restart the application for the new settings to

take effect.
Click OK.

Type the new IPv6 address (get this information from the network
administrator).

Configuring the AppleTalk Zone

This option enables you to change the AppleTalk network zone in which your Color
Controller C-80 appears.

Note: This option only applies to networks that contain Mac computers.

1.

In the Apple Talk setup area, verify that the displayed AppleTalk zone is correct.
Ifitis correct, Click Next and proceed to Configuring the Remote Tools Setup on
page 17. If it is not correct, click Change.

The Local Area Connection Properties dialog box appears, followed by the
AppleTalk Protocol Properties dialog box.

-L- Local Area Connection, Properties

General | Advanced

Connect using:

| ES Intel[R) PROA000 PM Metwork Cone

Thiz connection uzes the following items:
T MWwLink IF=</5F/MetBI0S Compatible Tranzport Prot #

S Network Moritor Diriver
L 2ppleT alk Protocal

S MetBEUI Protocal b
< ¥
[ Install... ] [ Uningtall ] [ Froperties
[rescription
AppleT alk Protocol

[] Show icon in notification area when connected
Motify me when thiz connection has limited or no connectivity

ok ][ Cancel ]

AppleTalk Protocol Properties

General |

Thiz spstem will appear in zone:

Ok ] [ Cancel
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2. Inthe This system will appear in zone list, select the required zone, and click
OK.

onnection Properties

General | Advanced|

AppleTalk Protocol Properties

General |

Thiz spstem will appear in zone:

MOVELL
050_ALPHA
[ sCite

STCL_BADAS
STCL_COMMUNICATION
STCL_DR&WING
STCL_MULTI_MEDIA
STCL_PLOTTERS =
—|5TCL_PRE_PRESS —
STCL_SCANMERS

i STCL_SCANMERS MANUFACTURING el
—STCL_TELEPRESS
[V Motify {5 gEC
STHA
[ QK ] [ Cancel ]

3. Inthe Local Area Connection Properties dialog box, click OK.

2.2.4 Configuring the Remote Tools Setup

WebViewer setup

__| Enable Webviswer

Remote workspace setup

Remote Tools Setup

| Enable Remate Connection
Connection Status: 0 Clients are connected

Logaf futomaticaly after 2 hous

Remote Connections Yiewer, ..

cmak | [weer | [ ol |

The WebViewer provides server information and enables you to view the status of
jobs in the print queue, the process queue, and the Storage area.
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The Remote Workspace opens an actual workspace for the selected server and
enables you to import jobs, print jobs, and perform certain workflows. Several users
can connect to the same server simultaneously from different remote workstations.

1. In the WebViewer area, verify that Enable Webviewer is selected.

2. In the Remote Workspace Setup area, verify that Enable Remote Connection
is selected.

Note: You can have up to 13 remote connections.
3. Tochange the Logoff Automatically after parameter, type the number of hours.

4. Click Remote Connections Viewer, to view the remote connections.

2.2.5 Configuring Security Settings

Passwords

Auto [og on

The password can conkain Up ko 30 characters

Disable guest connection

Disk wipe

_ Wips disk o system shutdown

< Back. Next > Cancel

Using the Default Password Settings

Note: The factory default password for Administrator and Operator users is colorserver. It
is used to log on to Windows and to connect to the Color Controller C-80 via the Microsoft
Remote Desktop Connection utility.

> In the Passwords area, verify that Auto log on is selected.

To change the administrator password:
1. In the Passwords area, clear Auto log on check box.

2. In the Passwords area, under Administrator, in the Enter old password box,
type the default password (colorserver).

In the Enter new password box, type a new password.

4. In the Verify new password box, retype the new password to confirm it, and
click Apply.
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To change the operator password:
1. In the Passwords area, clear Auto log on check box.

2. Inthe Passwords area, under Operator, in the Enter old password box, type
the default password (colorserver).

In the Enter new password box, type a new password.

4. In the Verify new password box, retype the new password to confirm it, and
click Apply.

To restrict guest access:

> In the Passwords area, under Guest, select the Disable guest connection
check box.

Using Default Disk Wipe Setting

The Disk Wipe utility enables you to work in a more secure environment, by
permanently removing data left by files that you have deleted. The utility eliminates
the contents of your deleted files by scanning all of the empty sectors on both the
system and image disks, and replacing them with zeros. Non-empty sectors are left
untouched. The Disk Wipe utility starts automatically every time you quit the Color
Controller C-80 software.

» In the Disk Wipe area, do one of the following:

O To enable the Disk Wipe utility, select the Wipe disk on system shutdown
check box.

O To disable the Disk Wipe utility, clear the Wipe disk on system shutdown
check box.



20 Chapter 2—First Time Setup and Configuration

2.2.6 Configuring Image Disks

ration Wizard

Image disks

Allow mirimum Free disk spacs: | 1,024 MB (Min: 1024 )

< Back ‘ Mext = ‘ Cancel

> Verify the minimum free disk space, and then perform one of the following
options:

O If the disk space is correct, proceed to the next screen in the wizard.

O If you need to change the amount of free disk space, enter the correct
minimum disk space that you require.

2.2.7 Configuring Backup and Restore Paths

Configuration backup

To: [ MGenerahConfigurationtconfiguration backup.cnf Erowse...

Start Backup
Restore configuration

Configuration Backup From:  T\GenersliConfigurationteonfiquration backup.crf Browse. .
Cali

Stark Restore

< Back. | Next > | Cancel

You can back up your configuration to a local hard disk, network drive, CD or DVD
media.
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The following settings can be backed up and restored:

* Server information

* Network setup

* Server resources

¢ System preferences

* Color tables

* Imposition templates

> In the Configuration backup area, select Browse to change the default path.

Note: The last path is saved and displayed in the path box. If the backup is made to
external media, the displayed path is the default:
C:\ColorControllerC-80\General\Configuration.

2.2.8 Setting the Calibration Reminder

Calibration reminder

Set calibration reminder every (hours): 245 hours

< Back | Next > | Cancel

Set the calibration reminder to remind you when to perform a calibration.

»> In the Calibration reminder area, select the Set calibration reminder every
(hours) check box and select the number of hours from the list.

The calibration reminder indicator m appears in the workspace when it is
time to calibrate.
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2.2.9 Setting the Localization Parameters

You configure the measurement unit, and language in the Localization window.

£ Configuration Wizard @

Units: | Inches -

Language: | English -

Localization

Region: | USA -

< Back ‘ Next = ‘ Cancel

1. In the Units list, select the required default measurement unit.
2. In the Language list, select the required interface language.

3. In the Region list, select the region in which you are working.
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2.2.10 Configuring the Deletion Policy

£ Configura

Deletion policy

|__ Automatically delete jobs from storage after
o) After

After

Held jobs

_ Delete held jobs after:

Deletion pol

0P P

JDFIMF

< Back ‘ Next = ‘ Cancel

In the Deletion policy area, select the Automatically delete jobs from storage
check box and then select one of the following:

e After 30 days

* After 12 hours

Then, enter the desired number of days or hours.

Note: Change the number of days or hours depending on your site requirements.

In the Held jobs area, select the Delete held jobs after check box, and enter the
desired number of hours.

Note: A held job is one that is bypassed in the Print Queue.
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2.2.11 Configuring the Pre-RIP Preview

PostScript preview

wihen closing the Adobe Acrobat praview window
| 5ave file a5 PDF
| Return ko the original PostScript file

VDP jobs preview

Mumber of buooklets For pre-RIP preview: =8

< Back. | Next > | Cancel

1. In the PostScript preview area, specify the desired action when you close the
Adobe Acrobat preview window:

O Save file as PDF
O Return to the original PostScript file

2. Inthe VDP jobs preview area, select the desired number of booklets that you
want to preview before the job is processed.



25

2.2.12 Configuring the Queues Manager

< Gonfiguration Wizand

Job batching policy

(®) Enabls job batching
\_ Disable job batching

Held jobs policy

|8 Bypass held jobs
|_J Dot bypass held jobs

-RIP

Queues Manager

< Back Mext = Cancel

Job Batching Policy
> In the Job batching policy area, do one of the following:

¢ Select Enable job batching to print jobs that have similar attributes one after
the other without having the printer pausing in between jobs.

¢ Select Disable job batching to discontinue printing jobs that have similar
attributes and enable the printer to pause in between printing jobs.

Held Jobs Policy
> In the Held jobs policy area, do one of the following:

* Select Bypass held jobs - to bypass held jobs in the Print Queue.

Note: This option moves the next job to the top of the Print Queue and saves
valuable production time.

* Select Don't bypass held jobs - to stop printing from the Print Queue when
a job is assigned a held status.

Note: This option preserves the original order of the files in the queue.
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2.2.13 Configuring Messages

Accounting log setup
Overwrite messages after: a0 days

Message viewsr log setup

Overwrite messages after: a0 days

Messages

JDF/IMF

< Back | Next > | Cancel

1. Inthe Accounting log setup area, enter the number of days after which you can
overwrite messages, if different than 90 days.

2. In the Message viewer log setup area, enter the number of days after which
you can overwrite messages, if different than 90 days.

2.2.14 Configuring JDF Output and JMF Signals

IDF outputs

_| Create JDF outputs
& &l jobs
Orly source DF jobs

ID:\Ltilties JOF Reports

MF signals For job status

__ Send JMF signals

< Back ‘ Next = ‘ Cancel

The Color Controller C-80 receives the JDF job ticket via hot folders, returns JDF
output with job accounting information, and submits JMF (Job Messaging Format)

signals with the job's status.
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If the JDF job has a target path specified in the job, JDF output is always created.
For JDF jobs that do not have a specified target path, the JDF output is only created
if this option is selected in the Configuration Wizard.

1. In the JDF outputs area, select the Create JDF outputs check box, and select
one of the following options:

¢ Select All jobs to create JDF reports for all jobs.

¢ Select Only source JDF jobs to create JDF reports from only source JDF
jobs.

2. Inthe Target path box, type the target path or click Browse to locate the
directory for the JDF output.

3. Inthe JMF signals for job status area, select the Send JMF signals check box
to receive JMF signals about the job’s status.

4. Inthe HTTP URL box, type HTTP URL . This enables you to submit JMF signals
with the job status each time that the job status of a job in the system changes.

2.2.15 Configuring General Defaults

£ Configuration Wizard @

Default Image Size

Size: | A3 -

|_J Enabls OPI suppart
Support Helios server

#, Disable OPI suppart

Default archive path

Archiving path: wents and Settings\operatoriMy DocLments Browse. .

Job title recognition

|®) Use PostScript internal name:

_J Use files name (Use when Printing via LPR)

Offset between jobs

General Defaults
Offset batween jobs

Configuration Type

< Back Next = Cancel

Default Image Size

When a PDL file does not contain page size information, the RIP uses a predefined
default size. This default size is defined according to the unit of measurement that
you have selected during the first-time configuration.

» In the Default Image Size area, select the desired size.

OPI Support

OPI Support automatically creates a low-resolution image of all supported file
formats for placement in any layout application. It replaces layout images on-the-fly
with optimized high-resolution images during output.
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Setting Default archive path

> If you want to set a default path in which to archive jobs, click Browse and locate
the folder.

Job Title Recognition
> In the Job title recognition area, select one of the following options:

O Use PostScript Internal name : This option uses the internal file name as
written inside the PostScript file by the print driver. Use this option when
spooling from Mac OS X.

3O Use files name (Use when printing via LPR): Uses the job’s given file name.
Selecting this option ensures that the job appears in the
Color Controller C-80 with the name last given by the user.

Cached global VDP elements

> Select the Always cache global VDP elements check box to cache and store
VDP elements for reuse.

Offset between jobs

This option changes the paper output position after the last page of the job is printed.

2.2.16 Completing the Configuration

After the installation is complete, the following window appears.

nfiguration Wizard

Configuration Completed

< Barck Finish Cancel

1. Click Finish.
The configuration settings are automatically backed up.

After a few moments, the Color Controller C-80 workspace appears on your
screen.
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2. Exit the Color Controller C-80 software. If you made any changes to the
configuration, these changes will only take effect if the Color Controller C-80 is

shut down and then restarted.

3. Quit any other software that may be running and, from the Windows Start
menu, select Shut Down > Restart > OK.

Note: Make sure to turn off your printer before you restart the Color Controller

C-80. After the Color Controller C-80 restarts and the Color Controller C-80

workspace appears, you can turn on the printer.

After restarting, the Color Controller C-80 software splash screen appears.
4. The Color Controller C-80 software is automatically loaded and launched.

A backup of the operating system should be performed after the system
configuration is completed, see Backing Up the System Partition on page 42.

2.3 Configuring McAfee VirusScan

For best results, install McAfee VirusScan® software on your Color Controller C-80.
After you have installed McAfee VirusScan software, perform the following
configuration procedures.

Important: Running VirusScan software could slow down process time
and affect the overall performance of the server.

Once a year, the site manager must obtain the latest version of the antivirus
software and installation procedure. The site manager must also regularly download
the latest antivirus definitions from the relevant Internet site.

Note: The following VirusScan software configuration procedure is subject to
change without notice, and the relevant documentation may not be updated.

2.3.1 Configuring the Scan All Fixed Disks Settings

1. From the taskbar, right-click the VShield icon and select VirusScan Console.

= YirusScan Console g@@

Task Edit Wiew Tools Help
g = ® B AP Y

Task Status Last Result

§ Access Prokection & port blocking rules are defined. 5.,
m Buffer Overflow Protection Enabled
[=] on-Delivery E-mail Scanner Enabled
@ Unwanted Programs Policy Mo unwanted program categories ar...
@ On-Access Scanner Enabled

Scan All Fixed Disks Mot Scheduled
Autolpdate Daily, 5:00 PM The Update succeeded

< *

VirusScan Console

2. In the Task column, right-click Scan All Fixed Disks and select Properties.

3. Click the Detection tab.
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W VirusScan On-Demand Scan Properties - Scan All Fixed Disks |2 rg|

Task Help
'_W'herej Detection | Advanced | Actions_ Urwanted Programs 4 * oK
% Specify which items are scanned. Cancel
Wwhat to scan

(O]

(O Default + additional file types (0]

Start

Beset to Default

Save as Default

what not to scan Schedule
Exclude disks, files, and folders [0] -

Help
Comprezzed files

[] 5can inside archives [far example, ZIF)
[] Decode MIME encaded files

(O Specified file types (0]

JARER £

4. In the What not to scan area, click Exclusions.

¥ Set Exclusions

g% Select files, folders, and drives to be excluded fram virs scanning.
Itern Exclude Subfolders
5. Click Add.

% Add Exclusion Item

Wwhat to exclude
By name/lacation [can |

[ Browse. ..

[ &ls0 exclude subfolders

O By file type [can include wildzards * or 7):

[ ]

O By file age:
Access type: Minimum age in days:

(O Files protected by \Windows File Protection

Wwhen to exclude

Cancel ] [ Help

6. Click Browse.
7. In the Browse for Folder dialog box, locate the D:\QOutput folder, and click OK.
The D:\Output path appears.
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v Edit Exclusion Item

Wwhat to exclude
@by
| Cr:AOutputt, | [ Browse... ]

Alzo exclude subfolders
O By file type [can include wildzards * or 7):

[ ]

O By file age:
Access type: Minimum age in days:

(O Files protected by \Windows File Protection

Wwhen to exclude

[ Cancel ] [ Help ]

8. Select the Also exclude subfolders check box and click OK.

9. Inthe Set Exclusions dialog box, click OK, and then click OK again.

2.3.2 Configuring the On-Access Scan Settings

1. Return to the VirusScan Console window.

= YirusScan Console
Task Edit Wiew Tools Help

e B dH2Y

Task Status Last Result

§ Access Prokection & port blocking rules are defined. 5.,

m Buffer Overflow Protection Enabled
[=] on-Delivery E-mail Scanner Enabled
E Unwanted Programs Policy Mo unwanted program categories ar...
On-fi anner Enabled
ﬂ Scan All Fixed Disks Mot Scheduled
ﬁ Autolpdate Daily, 5:00 PM The Update succeeded
< | >

VirusScan Console
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2. In the Task area, right-click On-Access Scanner and select Properties.

- YirusScan On-Access Scan Properties

General |.Script8c:an I .Elocking I Message§ Heport§=

M @ These tabs affect all applications.

General
Seftings 3

Floppy during shutdown

General
Enable on-access scanning at system startup

Huarantine Folder:

|\quarantine\ H Browse... ]

Scan time

M aximum archive scan time [zeconds): 15 =~

Enforce a maximum scanning time for all files

M aximum scan time [seconds]: (45 :

3. On the left of the window, click the All Processes icon.

[ Ok ][ Cancel ]

4. Select the Detection tab.

% YirusScan On-Access Scan Properties

| Processe.s.| Detection |Advanced f: Actions | Urwwanted Programs |

M @ Specify what items will be scanned.

General
Settings Scan Files
L
@ when reading from disk
Al [] O metwaork, drives
Processes
what to scan
) Al files

(O Default + additional file types (0]

(O Specified file types (0]

what not bo scan
Exclude disks, files, and folders [2]

Excluzions...

Ok ][ Cancel ]
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10.

In the What not to scan area, click Exclusions.

% Select files, folders, and drives to be excluded fram virs scanning.

Exclude Subfolders Readfwiite
R eadwiite

af... n'a Fead

Bemove
LClear

Help

In the Set Exclusions dialog box, click Add.

% Add Exclusion Item

Wwhat to exclude
(B name/location [can include wildeards * orﬂf._.-._.___\
=
| K[ Browse. .. D
——

[ &ls0 exclude subfolders

O By file type [can include wildzards * or 7):

[ ]

O By file age:
Access type: Minimum age in days:

(O Files protected by \Windows File Protection

Wwhen to exclude
On read
On write

Cancel ] [ Help

Click Browse.

In the Browse for Folder dialog box, locate the D:\Output folder and click OK.

% Add Exclusion Item

Wwhat to exclude
(%) By namedlocation (zan include wildsards * or 7):

|D:\Dutput\ | [ Browse... ]

() By file type [can include wildzards * or 7):

[ ]

() By file age:
Access type: Minimum age in days:

() Files protected by \Windows File Protection

Wwhen to exclude
On read
On write

[ QK l [ Cancel ] [ Help ]

Select the Also exclude subfolders check box and click OK.

In the Set Exclusions dialog box, click OK.
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11. In the VirusScan On-Access Scan Properties window, click OK.

2.4 Performing a Test Print and Color Image Check

To import a file and perform a test print:

1.
2.

From the File menu, select Import.

Locate one of the following files:

* Golfer_Letter.pdf in the D:\Sample_Files\USA\General folder
* Golfer_A4.pdf in the D:\Sample_Files\Europe\General folder
Double-click the file to add it to the list for importing.

Select the ProcessPrint virtual printer.

Click Import.

The file is processed, printed, and sent to the Storage area.

Note: If the job does not print or is waiting in the Print Queue, make sure that the
default virtual printer parameters are set to the current finishing device. (Job
Parameters > Finishing).

To import a file and perform a color image check:

1.
2.

From the File menu, select Import.
Locate one of the following files:

* Letter_Color Test Chart.pdf in the D:Sample_Files\Color Files\Color Test
Chart

* A4 _Color TEST Chart.pdf in the D:Sample_Files\Color Files\Color Test
Chart

Double-click the file to add it to the list for importing.
Select the ProcessPrint virtual printer.
Click Import.

The file is processed, printed, and sent to the Storage area.

Color Test Chart

MY CMY K

-~ OO0O00

-

8
H
EEE
]
d Jd 3 3

« [ ] |
- [l HBE
A HE HE

Check that each 100% pattern (A) has a solid color and that there are no
imperfections (not blotched or scratched).
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7. Check that the density difference between the 60% patterns (B) and 50%
patterns (C) is clearly visible.

8. If a problem appears on the test print, perform the following steps:

* For solid color problems: On the printer control panel, enter the SP mode,
and then execute the process control with SP3-820-002.

* For density difference problems: Perform color calibration on the Color
Controller C-80.

Note: If the job does not print or is waiting in the Print Queue, make sure that the default
virtual printer parameters are set to the current finishing device. (Job Parameters >
Finishing).
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3.1

When To Reinstall

This chapter describes the installation procedures for the Color Controller C-80. It
describes how to reinstall the operating system, and how to reinstall the Color
Controller C-80 software.

If you are upgrading an existing site or reinstalling, it is essential to capture and save
all critical information before starting the installation procedure. This information
could be lost if it is not saved to an external device or network in the event of a
system crash.

The installation is mostly unattended. User interaction is needed only for entering
the computer hostname, for restarting the computer when requested, for activating
Windows XP operating system, and for inserting DVD 1 and DVD 2.

There are three methods for reinstalling the system:

* Complete Installation,deleting old jobs: This procedure requires two discs,
DVD 1 and DVD 2. It installs a clean system with the Color Controller C-80
software and formats disk C and disk D. Complete Overwrite overwrites the
operating system.

Perform this installation under the following conditions:
O When installing a new operating system

3 When physically replacing the system disk

O When upgrading the system disk

* Preservation Installation (System Partition Overwrite): This procedure requires
two discs, DVD 1 and DVD 2. It installs the Color Controller C-80 software and
formats only the system partition. In other words, disk C is reformatted and
reloaded, and the information on disk D is preserved and not deleted.

Perform this installation under the following conditions:

O When the Windows XP operating system is corrupt and needs to be
reinstalled

3 After an unrecoverable system crash
O When you are upgrading the operating system

¢ System Backup/Restore Tool: This procedure only requires DVD 1. It is the
fastest method in which to reinstall the system drive. Use this procedure if you
have the latest software version and software updates installed, and you want to
keep an image file that can be restored later on.

O Back up and restore only partition C —Norton Ghost software copies the files
on partition C to an image file on partition D, and restores partition C from the
image file on partition D.

O Back up and restore partitions C and D—Norton Ghost software copies the
files on partitions C and D to a DVD, and restores partitions C and D from the
backup

Perform this installation under the following conditions:
O After an unrecoverable system crash

0 When the Windows XP operating system is corrupt and needs to be reinstalled



39

3.2

Installing the Operating System and Software

The following table summarizes the procedures you need to perform before and
after you reinstall, and tells you where to find the information for this section. Before
you start, review the table to familiarize yourself with the procedures. You can also
use the table as a check list to verify that you have completed all the required
procedures.

Table 1: Tasks to perform for reinstallation

Step

Section in this book

1.

Archive any important customer jobs to
an external device

See Color Controller C-80, Powered
by Creo Color Server Technology,
for Pro C900 User Guide
(731-01699A-EN)

2. Reinstall the operating system page 39
(Windows XP) and Color Controller C-
80 software (Complete Installation or
Preservation Installation)

3. Perform first time configuration wizard |page 16

4. Install and configure virus protection |page 29
software (highly recommeded)

5. Perform test print page 34

6. Restore customer jobs

See Color Controller C-80, Powered
by Creo Color Server Technology,
for Pro C900 User Guide
(731-01699A-EN)

Back up the Color Controller C-80
system partition ( highly
recommended)

page 42

Note: Check if VIPP or other Creo supported software is loaded on the Color Controller C-
80. Such software must be reloaded after the Complete Overwrite installation is completed.

Before reinstalling, ensure that:

All external devices are disconnected from the Color Controller C-80

The software pack (DVD 1, DVD 2) is available

The following information is available for the Color Controller C-80:

Computer name

TCP/IP information

a o a a

AppleTalk zone information

a IPX information

Important: Always disconnect the network cable before installing
software.

Gateway, WINS address, and DNS information (if DHCP is not active on site)
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If the Color Controller C-80 is on and the Color Controller C-80 workspace is
open:

a. Exit the workspace.
b. Place DVD 1 (Fast Install) into the DVD-RW drive.

c. Fromthe Windows Start menu, select Shut Down > Restart > OK. Wait until
the Color Server Startup menu appears and then proceed to step 2.

If your Color Controller C-80 is off:
a. Press the Power On/Off button on the front panel.

b. As soon as power is applied, place DVD 1 (Fast Install), into the DVD-RW
drive.

c. Wait until the Color Server Startup menu appears.

When the Color Server Startup menu appears, the following options are
available:

* Complete Installation, deleting old jobs

* Preservation Installation (System Partition Overwrite)

* System Backup Tool

* Exit

On the keyboard, press the number of the option you want to perform:
* Press 1 to perform a complete installation

* Press 2 to perform preservation installation

The confirmation message Are you sure? appears.

Press y (Yes) to confirm your selection.

Note: To return to the ColorServer Startup menu, click N (No).

The system starts copying the files. This process takes about ten minutes, and
then the following message appears:

Please remove any media from the DVD-RW drive and press
Ctr1+Alt+Del to reboot the computer.

Remove DVD 1 from the DVD-RW drive, and press CTRL+ALT+DELETE to
restart.

In the Computer Name and Administrator Password screen, type the name for
the Color Controller C-80—for example, C80_WinXP.

Important:
In the Administrator Name and Password area, use the default settings.

If required, you can change the administrator name and password, but only at
the end of the installation process. See Configuring Security Settings on
page 18.

Click Next.
The installation process continues.

At the end of the installation the system restarts.
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10.

11.

12.

13.

Insert DVD 2 into the DVD-RW drive.

The Color Controller C-80 software splash screen appears.
Click Start.

The Acrobat software setup begins.

After the Acrobat software setup is complete, the Color Controller C-80
installation starts.

When the License Agreement window opens, click Yes to continue the Color
Controller C-80 installation.

When the installation is complete:

a. Click Finish to restart the computer.
Note: Ifthe Wrong Disk Configuration message appears after
you restart the computer, the disks need to be striped. See Disk Striping
on page 77.

b. Remove DVD 2 from the DVD-RW drive.
When the application starts the following message appears.

Image Disks FileSystem Is Mot Formatted.,
Press Ok To Format,

c. Click OK.

d. Proceed to Configuration Wizard (First-time Software Setup) on page 11.
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3.3 Backing Up the System Partition

Back up the Color Controller C-80 system partition so that you always have a
working copy of your software to be able to restore your system, if necessary. It is
best practice to back up the system partition each time you update the Color
Controller C-80 software, update the system cofiguration, perform a complete
installation, or update the operating system.

Note: Jobs located in the queues and the Storage area are not backed up.

Attention: Before performing the backup and restore procedures, make sure that
your computer’s configuration is the one that you want to use when restoring the
system.

Tip: Itis recommended that you delete unnecessary files, such as temporary
files, and all jobs in the workspace before performing the backup procedure.

Note: If you are already logged onto your system and the Color Controller C-80 workspace
is open, exit the workspace, insert DVD 1 into the DVD-RW drive, and proceed to step 3

1. Turn on your Color Controller C-80.
2. Place DVD 1 (Windows XP Fast Install) into the DVD-RW drive.
3. Restart the Color Controller C-80.
4. Wait until the Color Server Startup Menu appears.
The following options are available:
1.  Complete Installation, deleting old jobs
2. Preservation Installation (System Partition Overwrite)
3. System Backup/Restore Tool
4. Exit
5. Press 3 to use the System Backup Tool.
6. Type Y to confirm your selection.

The System Backup/Restore Tool menu appears.

System Backup / Restore Tool

Caution!!!

It is strongly recommended that you back up/restore both the C and D
partitions at the same time to prevent possible synchronization problems
between these partitions.

1. Back up system partition C to partition D

2. Restore system partition C from partition D

3. Back up partitions C and D to a DVD media

4. Restore partitions C and D from the DVD media
5. Exit and return to Main menu

Select an operation [1,2,3,4,5]?

Tip: If you want to copy the files to an external device, copy only the files
located on D:\Backup that begin with SYSPART.
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7. To back up system partition C, press 1. This option backs up the files on
partition C to an image file on partition D.

The Norton Ghost window appears.
e. If a Norton License Agreement window appears, click OK to continue.

Norton Ghost copies the files on partition C to an image file on partition D.
The process takes about 8 minutes to complete.

f.  When a message appears instructing you to remove the DVD from the
DVD-RW drive and restart the computer, remove the DVD and press
Ctr1+Alt+Delete to restart the Color Controller C-80.

8. To back up the entire system (partitions C and D), press 3. This option backs up
partitions C and D. You may need more than one DVD for the backup.

a. Press Y to continue.

The following message appears:

Back up partitions C and D to a DVD media

Note that the backup procedure of the system partition
may require up to 3 DVD + R or DVD + RW Disks depending on the
amount of data stored on the partition.

Number the DVD disks in the order they are created to facilitate easy
restoration.

Continue?[Y,N]?

b. To continue, press Y.

The following message appears:

Back up partitions C and D to a DVD media

Place a DVD media in
The DVD drive.

Wait until the LED on the
DVD drive turns off.

Press any key to continue . ..

c. Follow the instructions in the message.
Norton Ghost copies the files on partitions C and D to the DVD.

Note: If an error occurs during the backup process, a message appears
asking you to contact customer support. Press any key to continue and
the Color Controller C-80 restarts automatically.
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d. When a confirmation message appears notifying you that the backup
process was successfully completed, remove the DVD from the DVD-RW
drive and press any key to continue.

The Color Controller C-80 restarts automatically.

3.4 Restoring the System Partition

Important: Always disconnect the network cable before installing
software.

The Color Controller C-80 enables you to restore partition C or the entire system
(partitions C and D). Restore the software on your Color Controller C-80 after an
unrecoverable disk crash, or when the system exhibits unpredictable behavior—for
example, error messages suddenly appear or occasional the user interface freezes.
The process takes 20 - 30 minutes, depending on the size of the partition.

Performing the restore procedure requires a previous backup.
1. Exit the Color Controller C-80 work space.
2. Insert DVD 1 (Windows XP operating system) into the DVD-RW drive.
3. From the Windows Start menu, select Shut Down > Restart > OK.
After the system restarts, the Color Controller C-80 Startup Menu appears. The

following options are available:

1. Complete Overwrite Installation, deleting old jobs

2. Preservation Installation (System Partition Overwrite)
3. System Backup/Restore Tool

4. Exit

4. Press 3 to use the System Backup/Restore Tool.

5. Press Y to confirm your selection.

System Backup / Restore Tool

Caution!!!

It is strongly recommended that you back up/restore both the C and D
partitions at the same time to prevent possible synchronization problems
between these partitions.

1. Back up system partition C to partition D

2. Restore system partition C from partition D

3. Back up partitions C and D to a DVD media

4. Restore partitions C and D from the DVD media
5. Exit and return to Main menu

Select an operation [1,2,3,4,5]?

6. To restore only partition C, press 2. This option restores partition C from the
image file on partition D.

Note: Before restoring the color server system partition, you may need to
return the ghost file or files that you moved to an external device to
D:\Backup.
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A

The following message appears.

The restore process is irreversible and overwrites
all information on the system partition.

Continue and restore system partition ??
Yes / No

WARNING: The restore procedure erases all data on your system
partition C.

* If you click No, the following message appears:

Please remove any DVD media from the drive and press
ctrl+alt+delete to reboot the computer.

* If you click Yes, the Norton Ghost window appears and the image file on
partition D is restored to partition C.

When the process is complete, the following message appears:

Please remove any DVD media from the drive and press
CTRL+ALT+DELETE to reboot the computer.

* Remove the DVD from the DVD-RW drive and press CTRL+ALT+DELETE
to restart.
7. Torestore partitions C and D, press 4. This option restores partitions C and D
from a backup media.

a. Press Y to continue.

warning 1!

This process will erase
all data on your system disk.

Y OAre you sure

b. PressY to continue.

rRestore partitions C and 0 from the DvD media

Place backup DvD disk 1
in the pvo drive.

If multiple DvDs were created during
the backup process, be sure to insert
the disks in the order they were created.

wait until the LED on the
ovD drive turns off.

c. Follow the instructions in the message.
d. Press any key on your keyboard to continue.
Norton Ghost software copies the files on the DVD to partitions C and D.

Note: If an error occurs during the restore process, a message appears
asking you to contact customer support. Press any key to continue. The
computer restarts automatically.
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e. When a confirmation message appears notifying you that the restore
process was successfully completed, remove the DVD from the DVD-RW
drive and press any key to continue.

The computer restarts automatically. Proceed to Formatting the Image Disk.
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4.1 Platform Diagnostics and Configuring the Server

This section provides basic troubleshooting information to help you resolve some
issues that might possibly occur with the Color Controller C-80.

To maintain the good health of the server, it is important that the server continuously
remains correctly configured. An incorrectly configured server will deliver poor
performance, and the diagnostic results will be adversely effected.

4.1.1 Configuring Tools Overview

The following configuration programs are also provided to assist you in configuring
the server, and to provide diagnostic information:

¢ BIOS Setup Utility
* Gigabit Ethernet Controller

* LAN speed verification

Phoenix cME FirstBIOS Pro

This program controls the basic input/output system (BIOS) code in your server. Use
BIOS setup utility to:

* View configuration information.

* View and change assignments for devices and I/O ports.

* Set the date and time.

* Set the startup characteristics of the server and the order of startup devices.
¢ Set and change settings for advanced hardware features.

* View and clear error logs.

* Resolve configuration conflicts.

Gigabit Ethernet Controller
The Ethernet controller is integrated on the system board.

* It provides a interface for connecting to a 10-Mbps, 100-Mbps, or 1000-Mbps
network and provides full duplex (FDX) capability, which enables simultaneous
transmission and reception of data on the network.

* If the Ethernet port in the server supports auto-negotiation, the controller detects
the data-transfer rate of the network (10BASE-T, 100BASE-TX, or 1000BASE-
T) and automatically operates at that rate, in full-duplex or half-duplex mode, as
appropriate.

* The Ethernet controller supports optional modes, such as teaming, priority
packets, load balancing, fault tolerance, and virtual LANs, which provide better
performance, security, and throughput. These modes apply to the integrated
Ethernet controller and to controllers on supported Ethernet adapters.
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Troubleshooting the Ethernet Controller

This section provides troubleshooting information for problems that might occur with
the 10/100/1000-Mbps Ethernet controller.

To resolve network connection problems:

If the Ethernet controller cannot connect to the network, perform the following:

Check the BIOS configuration relating to the LAN.

Verify that the cable from the LAN connector on the server is connected to the
LAN.

Check that the network cable is attached at all connections. If the cable is
attached but the problem persists, try a different cable.

Check the LAN activity light on the rear of the Color Controller C-80. The LAN
activity light illuminates when the Ethernet controller sends or receives data over
the Ethernet network. If the LAN activity light is off, ensure that the hub and
network are operating and that the correct device drivers are loaded.

Verifying the LAN Speed

Use the following procedure to make sure that your system is operating at the
maximum speed of the network.

1.

Right-click My Network Places, and select Properties.
The Network Connection window appears.

Right-click Local Area Connection, and select Properties.

-L- Local Area Connection Properties [E]g|

General | Advanced
Connect using:

B IntellR) PROA000 PR Metwork Cone

Thiz connection uzes the following items:

=t Client for Microzoft Metworks -
.[% File and Printer Sharing for Microsaft Metworks
BQDS Packet Scheduler

5 AooleT alk Protocol b
< ¥
[ Install... ] [ Uningtall ] [ Froperties
[rescription

Allows pour computer to access resources on a Microzoft
hetwork.

Show icon in notification area when connected
Motify me when thiz connection has limited or no connectivity

[ (] 8 ][ Cancel ]

3. Select the Show icon in taskbar when connected check box and click OK.
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4. Roll the cursor over the network icon in the taskbar to display the speed, as
shown in the following example:

Local Area Connection
Speed: 100.0 Mbps
Skatus: Connecked

N & Ji= Ce i M

4.1.2 Using the Configuring Tools

Using the Phoenix cME FirstBIOS Pro Setup Utility

This section provides instructions for starting the Phoenix cME FirstBIOS Pro Setup
Utility and descriptions of the menu choices available for configuring the BIOS.

Important: It is recommended that you do not alter any BIOS settings unless
they do not follow the recommendations in this section. Faulty BIOS settings
could cause the system to fail or to operate incorrectly.

Starting the Phoenix cME FirstBIOS Pro Setup Utility
1. Quit the color server software.
2. Restart the Color Controller C-80 and immediately press DELETE.

The Phoenix cME FirstBIOS Pro Setup Utility window appears.

Selecting From the Phoenix cME FirstBIOS Pro Setup Utility Main
Menu

You can select settings that you want to change from the BIOS Setup Utility Main
menu.
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The Phoenix cME FirstBIOS Pro Setup Utility Main menu is similar to the following:

Phoenix ¢cME FirstBIOS Pro Setup Utility

Main Advanced Security Boot Exit
Item Specific Help
System Date: [01/21/2009]
Legacy Diskette A: |Disabled]
BIOS Date 11/17/06
Hard Disk Pre-Delay: |3 Seconds]
Serial ATA: |Enabled]
Native Mode Operation: [Serial ATA]
SATA RAID Enable: | Disabled]
SATA AHCI Enable [Disabled]
» SATA Port 0 [None]
» SATA Port 1 [CD-ROM|
» SATA Port 2 [250GB SATA3|
» SATA Port 3 [250GB SATA4|
» SATA Port 4 [250GB SATAS|
» SATA Port 5 [250GB SATAG6]
System Memory: 634 KB
F1 Help * ¥ Select Item -+ Change Values F9  Setup Defaults
Esc Exit +—+ Select Menu Enter Select » Sub-Menu F10 Save and Exit

Note: The choices on some menus might differ slightly from the ones that are
described in this manual. The menu choices depend on the BIOS version in the

server.

Figure 5:

Descriptions of the choices that are available from the main menu are as follows:

¢ System Time: Sets the system date and time. The system time is in a 24-hour
format (hour:minute:second).

¢ System Date: Sets the system date. The system date is in the format (month/

dayl/year).
* Hard Disk Pre-Delay: Adds a delay before the HDD is accessed by the BIOS for

the first t

* Serial ATA: Allows the user to enable or disable the function of Serial ATA.

ime.
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Selecting From the Phoenix cME FirstBIOS Pro Setup Utility
Advanced Menu

Boot Features—Select this submenu to change the following settings:

o

Quick Boot Mode:

If enabled, this feature will speed up the POST (power-on self test) routine
after the computer is turned on. If disabled, the POST routine will run at
normal speed.

Quiet Boot:
Select this option to enable or disable the diagnostic screen during startup.

Advanced Processor Options:
Select this submenu to change the following settings.

o

CPU Speed:
This display indicates the speed of the processor.

Machine Checking:
If enabled, this feature allows the CPU to detect and report hardware
(machine) errors.

Compatible FPU Code:
This feature is for debugging only.

Adjacent Cache Line Prefetch:
If enabled, the CPU fetches both cache lines for 128 bytes.

Set Max Ext CPUID =3

Echo TPR:
This feature is for debugging only.

C1 Enhanced Mode:
If enabled, this feature lowers the CPU voltage and frequency to prevent
overheating.

Intel Virtualization Technology:

If enabled, this feature utilizes enhanced virtualization capabilities to allow
one platform to run multiple operating systems and applications in
independent partitions, creating multiple virtual systems in one physical
computer.

Disabled is the default setting. If you change this setting, you must restart
your computer for the change to take effect.

No Execute Mode Memory Protection:
If enabled, this feature allows the processor to classify areas in the memory
where an application code can execute and where it cannot.

Enhanced Intel Speed Step:
This setting allows you to determine the processor power management
mode.

I/0 Device Configuration:
Select this submenu to change the following settings:

o

o

o

KBC Clock Input: This setting allows you to set the keyboard clock rate.
Serial Port A: This setting allows you to assign control of serial port A.

Serial Port B: This setting allows you to assign control of serial port B.
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O Floppy Disk Controller: This setting allows you to assign control of the floppy
disk controller.

Hardware Monitor:
Select this submenu to change the following settings:

O CPU Temperature Threshold: This option allows you to set a CPU
temperature threshold that will activate the alarm system when the CPU
temperature reaches the predefined temperature threshold.

O Fan Speed Control Modes: This option allows you to decide how the system
controls the speed of the on-board fans.

3 Voltage Monitoring

O System Event Log

O Real Time Sensor Data

Selecting From the Phoenix cME FirstBIOS Pro Setup Utility Boot
Menu

Boot Priority Order and Exclusions From Boot Order
For details on how to change the order and specifications of the boot order, see
the Item Specific Help area.

Selecting From the Phoenix cME FirstBIOS Pro Setup Utility Exit
Menu

Exit Saving Changes: This option allows you to save any changes that you
made and to exit the BIOS setup utility Setup Utility.

Exit Discarding Changes: This option allows you to exit the BIOS setup utility
Setup Utility without saving any changes that you may have made.

Load Setup Defaults: This option allows you to load the default settings for all
items in the BIOS setup. This is the safest setting to use.

Discard Changes: This option allows you to discard (cancel) any changes that
you made. You will remain in the BIOS setup utility Setup Utility.

Save Changes: This option allows you to save any changes that you made. You
will remain in the BIOS setup utility Setup Utility.

Configuring the Computer BIOS

1.

Start the Phoenix cME FirstBIOS Pro Setup Utility. See Starting the Phoenix
cME FirstBIOS Pro Setup Utility on page 50

The Phoenix cME FirstBIOS Pro Setup Utility window appears.

Tip: To modify any of the following values, use the arrow keys to move to the
required values, and the +, -, and numbered keys to change the values.
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2.

If required, change the System Date and verify that the rest of the settings are

the same as the settings in the following window.

a. Press ENTER to save any changes.

Phoenix ¢cME FirstBIOS Pro Setup Utility
Main Advanced Security Boot Exit
Item Specific Help

System Date: [01/21/2009]

Legacy Diskette A: |Disabled]

BIOS Date 11/17/06

Hard Disk Pre-Delay: [3 Seconds]

Serial ATA: |Enabled]

Native Mode Operation: [Serial ATA]

SATA RAID Enable: | Disabled]
SATA AHCI Enable [Disabled]

» SATA Port 0 [None]
» SATA Port 1 [CD-ROM|
» SATA Port 2 [250GB SATA3|
* SATA Port 3 [250GB SATA4]
* SATA Port 4 [250GB SATAS|
* SATA Port 5 [250GB SATAG)]

System Memory: 634 KB
F1 Help * ¥ Select Item -+ Change Values F9  Setup Defaults
Esc Exit +—+ Select Menu Enter Select » Sub-Menu F10 Save and Exit

3. Using the arrow keys, select the Advanced menu.

Phoenix ¢cME FirstBIOS Pro Setup Utility

Main Advanced

Security Boot

Boot Features

Advanced Processor Options
Advanced Chipset Control
Memory Cache

PnP Configuration

1/O Device Configuration
DMI Event Logging
Console Redirection
Hardware Monitor

YyYYyYvyvyvyvyvyv

Item Specific Help

Select Boot features

F1  Help t+ Select Item
Esc  Exit «—+ Select Menu

-+ Change Values
Enter Select » Sub-Menu

F9  Sctup Defaults
F10  Save and Exit

4. Using the keyboard arrow keys, select Boot Features and press ENTER.
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5.

10.

Verify that the settings are the same as the settings in the following window.

Phoenix ¢ME FirstBIOS Pro Setup Utility
Advanced
Boot Features Item Specific Help
Quiet Boot Display the graphic
QuickBoot Mode: [Enabled] screen during booting
ACPI Mode: | Yes] B
Power Button Behavior: [Instant-Off]
Resume On Modem Ring:  [Off]
Resume on PME# [On]
PS2 KB/MS Wake Up | Disabled)]
USB Wake Up | Disabled]
Power Loss Control: |Last State|
Watch Dog: | Disabled]
Summary screen: |Enabled|
F1  Help * ¥ Select Item -+ Change Values F9  Sctup Defaults
Ese  Exit <+ Select Menu Enter Select » Sub-Menu F10  Save and Exit

Press ESC to return to the Advanced menu.
Using the arrow keys, select Advanced Processor Options and press ENTER.

Verify that the settings are the same as the settings in the following window:

Phoenix ¢cME FirstBIOS Pro Setup Utility
Advanced
Advanced Processor Options Item Specific Help
CPU Speed 2.66 GHz Determines whether the
2nd core is enabled.

Core Multi-Processing: m Disabled =2nd core

Machine Checking |Enabled] is disabled.

Compatible FPU Code | Disabled]

Thermal Management 2 [Enabled] Enabled = 2nd core

Adjacent Cache Line Prefetch |Enabled] is enabled.

Set Max Ext CPUID =3 | Disabled]

Echo TPR [Enabled]

C1 Enhanced Mode | Disabled]

Intel (R) Virtualization Technology  [Disabled]

No Execute Mode Mem Protection  [Enabled]

Enhanced Intel Speed Step |GUI/GU3 On1]
F1 Help * ¥ Select Item -+  Change Values F9  Setup Defaults
Ese Exit «— Select Menu Enter Select » Sub-Menu F10  Save and Exit

Press ESC to return to the Advanced menu.

Using the arrow keys, select I/0 Device Configuration and press ENTER.
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11. Verify that the settings are the same as the settings in the following window.

Phoenix ¢cME FirstBIOS Pro Setup Utility
Main Advanced Security Boot Exit
1/0 Device Configuration Item Specific Help
. Select clock frequency
KBC Clock Input: [12MHz| of KBC.
Serial port A: |Enabled|
Base /O address: [3F8|
Interrupt: [TRQ 4]
Serial port B: [Disabled]
Floppy disk controller: |Enabled]
F1  Help t ¥ Select Item -/ Change Values F9  Sctup Defaults
Esc Exit < Select Menu Enter Sclect » Sub-Menu F10 Save and Exit

12. Press ESC to return to the Advanced menu.
13. Using the arrow keys, select Hardware Monitor and press ENTER.

14. Verify that the settings are the same as the settings shown in the window in
following window.

Phoenix ¢cME FirstBIOS Pro Setup Utility
Advanced
Hardware Monitor Item Specific Help
CPU Temperature: Low
System Temperature: 3n°c
1)Full speed at 12V
CPU Fan = 3497 RPM 2) Optimized Server
FAN1 = N/A with 3-pin
FAN2 = N/A 3) Optimized Workstation
FAN3 = 2561 RPM with 3-pin
FAN4 = 2547 RPM 4) Optimized Server
FANS = 1753 RPM with 4-pin
Fan Speed Control Modes: ) 5) Optimized Workstation
with 4-pin

VeoreA :
MCH Core :
=12V :
V_DIMM

F1 Help * ¥ Select Item -+  Change Values F9  Setup Defaults

Ese Exit +— Select Menu Enter Select » Sub-Menu F10  Save and Exit

15. Press ESC twice to return to the BIOS setup utility Setup Utility main window.
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16. Select the Boot menu and verify that the settings are the same as shown in the

following window:

Phoenix ¢cME FirstBIOS Pro Setup Utility

Main Advanced Security

Boot priority order:
I: AllUSB LSI120
2: All USB KEY
3: All USB ZIP
4: All USB Floppy
5: All IDE CDROM
6: IDE CD: HL-DT-ST DVDRAM GH20NS10+(
7: IDE 2: ST3250310A8-(52)
8:

Excluded from boot order:
: IDE 3: ST3250310A8-(53)
: IDE 4: ST3250310A8-(54)
: IDE 5: ST3250310A8-(S5)
: AIlIDE HDD

Item Specific Help

Keys used to view or
configure devices:

Up and Down arrows
select a device.

<+> and <-> moves
the device up or down.
<f= and <r> specifies
the device fixed or
removable,

<x> exclude or include
the device to boot.
<Shift + 1> enables or
disables a device.

<1 - 4> Loads default
boot sequence.

: All USB HDD:

: AllUSB CDROM

: All PCISCSI
F1 Help * ¥ Select Item -+ Change Values
Ese Exit +—+ Select Menu Enter Select » Sub-Menu

F9  Setup Defaults
F10 Save and Exit

17. If the boot order is not the same as shown in step 16, or if one or more of the
devices that should appear in the Boot priority order list appears in the

Excluded from boot order list, do the following:

a. Using the arrow keys, select the device that you want to appear in the Boot

priority order list.

b. On your keyboard, press the X key to add the selected device to the bottom

of the Boot priority order list.

c. Move the selected device to its correct position in the Boot priority order

list.

* Press X repeatedly until the device reaches the correct order in the list.

18. Select the Exit menu.
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Phoenix ¢ME FirstBIOS Pro Setup Utility

Main Advanced Security Boot Exit

Item Specific Help

Exit System Setup and
Exit Saving Changes save your changes to
Exit Discarding Changes CMOS.

Load Setup Defaults
Discard Changes
Save Changes

F1  Help t+ Select Item -+ Change Values F9  Sctup Defaults
Esc  Exit «—+ Select Menu Enter Sclect » Sub-Menu F10  Save and Exit

19. Using the arrow keys, select Exit Saving Changes and press ENTER.

20. To view the BIOS setup utility Setup Utility summary window in detail, when the
system starts or restarts and the window appears, immediately press PAUSE
BREAK on your keyboard.

21. Press any key to continue.

You have completed Configuring the Computer BIOS.

Configuring the Gigabit Ethernet Controller

You do not need to set any jumpers or configure the controller. The device driver that
enables the operating system to address the controller is automatically installed
from DVD #1 (Fast Install SLP).

4.2 General Diagnostic Tools

The following tools are available to help you identify and resolve hardware-related
issues:

* PC health monitoring

* POST (Power-On Self-Test) beep codes, error messages, and error logs—
POST generates beep codes and messages to indicate successful test
completion or the detection of a problem.

For more information, see POST (Power On Self Test) on page 59.

4.2.1 PC Health Monitoring

This section describes the PC health monitoring features of the system board. The
system board has an onboard system hardware monitor chip that supports PC
health monitoring.
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An onboard voltage monitor will scan these voltages continuously. Once a voltage
becomes unstable, a warning is raised or an error message is sent to the screen.
Users can adjust the voltage thresholds to define the sensitivity of the voltage
monitor. To adjust the sensitivity, open the BIOS utility and select Advanced >
Hardware Monitor.

Fan Status Monitor with Firmware/Software On/Off Control

The PC health monitor can check the RPM status of the cooling fans. The onboard
3-pin CPU and chassis fans are controlled by the power management functions. The
thermal fan is controlled by the overheat detection logic.

Environmental Temperature Control

The system board has a CPU thermal trip feature. A thermal control sensor monitors
the CPU temperature in real time and will send a signal to shut down the system
whenever the CPU temperature exceeds a certain threshold. This works to protect
the CPU from being damaged by overheating.

Hardware BIOS Virus Protection

The system BIOS is protected by hardware so that no virus can infect the BIOS area.
This feature can prevent viruses from infecting the BIOS area and destroying
valuable data.

Auto-Switching Voltage Regulator for the CPU Core

The 3-phase-switching voltage regulator for the CPU core can support up to 60 A
current and auto-sense voltage IDs ranging from 1.1 V to 1.85 V. This will allow the
regulator to run cooler and make the system more stable.

4.2.2 POST (Power On Self Test)

When you turn on the Color Controller C-80, it performs a series of tests to check the
operation of its components and some of its installed options.

If POST finishes without detecting any problems, a single beep sounds, and the first
screen of the operating system or software program appears.

If POST detects a problem, more than one beep sounds and an error message may
appear on the screen.

Note: A single problem might cause several error messages.
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POST Beep Codes

Beep codes are sounded in a series of beeps.

One short beep indicates the successful completion of POST.

One long beep and two short beeps indicate that there is a video configuration

error.

A continuous beep indicates that no memory is detected.

Other beep codes are detailed in the following table.

Code Beep POST Routine Description Recovery Action
16h 1-2-2-3 BIOS ROM checksum * Try saving the BIOS.
* Replace the system board.
20h 1-3-1-1 Test DRAM refresh * Try replacing the memory.
* Replace the system board.
22h 1-3-1-3 Test 8742 keyboard controller Replace the keyboard.
2Ch 1-3-4-1 RAM failure on address line Replace the memory.
2Eh 1-3-4-3 RAM failure on data bits of low byte of Replace the memory.
memory bus
46h 2-1-2-3 Check ROM copyright notice Replace the system board.
58h 2-2-3-1 Test for unexpected interrupts * Remove and reseat the PCI
adapters, one at a time,
check if faulty, and replace
the faulty adapter.
* Reload a different BIOS.
* Replace the system board.
98h 1-2 Search for option ROMs. One long, two | * Try reloading the BIOS.
short beeps on checksum failure * Replace the system board.
B4h 1 One short beep before boot The system is functioning
correctly.

4.3 Color Controller C-80 Hardware Diagnostics

Software

The Color Controller C-80 diagnostics software is used for testing both proprietary
Creo hardware (FusionRA) and standard off-the-shelf hardware.

There is JOIND (Java Over the Internet Diagnostics)—an Color Controller C-80
client/server diagnostic controller—that runs locally or over a TCP/IP connection.
JOIND runs under a Windows platform (NT/98/2000/XP) and enables local
diagnostic testing of Color Controller C-80 products with user level support.
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If you encounter any problems during installation or during normal operation of the
Color Controller C-80, run the Color Controller C-80 diagnostics software to
determine the cause.

The diagnostic software is located on the Color Controller C-80. The software
receives and executes test requests and returns appropriate status responses.

A hierarchical diagnostics tree shows the FRUs (field replacement units) that can be
tested by JOIND (Color Controller C-80 diagnostics software). You can select an
individual component from the tree for testing, run batch tests of selected
components, or run a general test of all units by selecting the DFE option.

Results appear as PASS/FAIL.

4.3.1 Activating the Diagnostics Software

Notes:
Only run the Diagnostics utility after you exit the Color Controller C-80 software.

Wait for the Color Controller C-80 software taskbar icon to disappear before
continuing.

Quitting the Color Controller C-80 Software
1. In the Color Controller C-80 workspace, click the File menu and select Exit.

2. Right-click the Color Controller C-80 software icon in the Windows Quick
Launch toolbar and select ShutDown Color Server.

Starting the Diagnostics Software

1. From the Windows Start menu, select Color Controller C-80 > Color Controller
C-80 Tools > Diagnostics.

2. The diagnostics program initializes and the DFE User Diagnostics window
appears on the screen. See The Diagnostics Window on page 62.
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4.3.2 The Diagnostics Window

B DFE User, Diagnostics - Local

File ‘“iew Control Level Help

FQH* @@

Current Test |

Test Progress |

Batch Progress |

Diagnostics Tree

Last Result # Pass # Fail

='m
L‘|_ SubSystem 0
FusionFid,
+ HARD DRIVES

Figure 6: The DFE User Diagnostics window

The DFE User Diagnostics window is divided into four sections:

* The top section contains the Main Menu bar with five different menu options:
File, View, Control, Level, and Help.

* The next section under the Main Menu bar contains shortcut buttons for
performing the main JOIND operations.

* The third section is a monitoring area in which the progress of the tests appears.

* The fourth section is the Diagnostics tree (on the left) which displays boards and
components to be tested. On the right, it displays results as Pass or Fail. The
last result test performed on a specific component or batch of components also

appears.
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4.3.3 Main Menu Options

File Menu

Load Quick Batch |A Quick Batch is a pre-defined set of tests, performed

on all available components. The results of these
tests provide an overall view of the hardware
performance of the control station or process print
station. The Quick Batch option enables a quick
(approximately 10 minutes) general indication of the
malfunction and enables proceeding with a local
comprehensive test.

This set of tests should be used as an initial test. If
this test does not indicate a malfunction, the full
comprehensive test should be run.

Import Log File Imports the JOIND current log file in which the Pass/

Fail data is stored from the control station or process
print station to the client.

Exit

To exit the application.

View Menu

Test Log File

Stores information sent by JOIND. For each executed test,
JOIND uses this file to record the date and time of
execution, the loop number, the name of the test and the
test result. If the Rerun mechanism is ON, results for all
reruns are recorded. It is recorded in an HTML file and
appears in a browser.

Software
Configuration

Displays the software version information of JOIND (client
and server). Itis recorded in an HTML file and appears in a
browser.

Hardware
Configuration

Displays hardware information that is recorded in an HTML
file and is displayed in a browser.




64

Chapter 4—Diagnostics and Troubleshooting

Control Menu

Run Initiates a test session, after the items for testing in this
session are marked in the check boxes. When Loop Off is
selected, the test session terminates after each test has
been executed. When Loop On is selected, the loop
sequence is toggled on and the test session repeats until
the loop termination condition is reached.

Run Until Fail |Initiates a test session, after the items for testing in this
session are marked in the check boxes. When Loop Off is
selected, the test session terminates after each test has
been executed or until the first failure is detected by any
test, whichever comes first. When Loop On is selected, the
test session repeats until the loop termination condition is
reached or once a failure is detected, whichever comes
first.

Level Menu

User The default setting for the diagnostic testing and operations
on the diagnostic tree that provides indications regarding
faulty field replacement units (FRUSs).

Help Menu

Online Help Loads the HTML page that has access to all the topics
below.

JOIND Introduction to the Color Controller C-80 Remote Support

Components |concept and describes the JOIND components and GUI.

and GUI

Activating the |Describes the access modes Remote Support and how to

JOIND run them.

The JOIND Describes the JOIND main window, menus and options.

Main Window

The JOIND Description of the menu and sub-menus.

Menu Options

DFE

Not applicable.

About JOIND

Displays the JOIND version number and date.




Shortcut Buttons

The shortcut buttons are found beneath the main menu bar and are available for
performing the main operations when running diagnostics tests.

Initiates the Run command to perform a diagnostic test
running in loop or executing batch of tests.

Terminates a test running in loop or executing batch of
tests. This button appears only after the Run button was
selected.

Appears after the Stop button is selected or until the current
test is completed.

Activates the Errors command and accesses the Error
Buffer for all tests run or a Quick Batch. The contents of this
buffer are recorded in an HTML file which appears through
the HTML browser.

B @ 6 L

Enables quick access to the Error Buffer of a selected test.
The contents of this buffer are recorded in an HTML file
which appears through the HTML browser.

Executes the Loop Until Abort command, which toggles the
test sequence to Loop On. Loop Off is the default setting
when executing diagnostic tests.

Toggles the test sequence to Loop Off.

Quits the diagnostics software. Remember to stop any tests
that are running before exiting.

Selects specific menu options or tree nodes when help is
required.

SHOEENE

Monitoring

The monitoring area is beneath the shortcut buttons. It displays three levels of
monitoring progress:

Current Test |Shows the progress of the specific test be performed.

Test Progress |Shows the progress of component tests of a batch run.

Batch Shows the progress of the entire batch being run.
Progress
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4.3.4 Board Diagnostics

This section describes the diagnostics for the Color Controller C-80 boards.

The board included in this category is FusionRA.

Use the JOIND diagnostic utility to test the Color Controller C-80 boards. If a board
fails a test, first verify that it is properly connected (turn off the Color Controller C-80
and check the board connections including cables and pins; sometimes boards may
become loose in the PCI slot).

Important: Replace a board or a system component that continues to fail
its diagnostics test.

Note: Exit the Color Controller C-80 software prior to running the diagnostics
program.

FusionRA Board

Testing Input/Output Memory Modules
Tests the input and output memories on the FusionRA board.

Testing the FusionRA Board

Tests the internal electrical mechanism of the FusionRA board.

4.3.5 Performing a Diagnostic Test

Important: Prior to activating the diagnostics software, verify that the
drivers were loaded successfully (with no error messages during driver
loading).

1. Access the JOIND software. See Activating the Diagnostics Software on
page 61.

2. Select the components for testing from the diagnostics tree, or select DFE to
test the entire tree, or select Load Quick Batch from the File Menu. See File
Menu on page 63.

3. Click the Loop button to run the tests in loop mode.
4. Click the Run button to activate the diagnostics testing.

5. The system performs the tests and the results appear in the area of the
diagnostics tree: Pass or Fail.

6. If there are components that fail, click the Errors button to view all failed
components or click the Quick Error button to view a specific selected test.
Diagnostics Test Results
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This section lists the possible results of the diagnostics test and the recovery

actions.
Symptom Recovery Action
FusionRA 1. Verify that the FusionRA board is correctly seated.
board fails the 2. Verify that the memory tests passed. If one or both
test. memory tests failed, replace the failed memory
module and run the FusionRA test again.
3. If the FusionRA test fails again, replace the
FusionRA board.
The Input 1. Verify that the FusionRA board is correctly seated.
Memory fails 2. If the input memory fails again, replace the
the test. FusionRA board.
The Output 1. Verify that the FusionRA board is correctly seated.
Memory fails 2. If the output memory fails again, replace the
the test. FusionRA board.

4.4 Troubleshooting

The first group of troubleshooting procedures relate to the three main situations:
* The Color Controller C-80 does not turn on.
* The Color Controller C-80 turns on, but the operating system does not initialize.

* The Color Controller C-80 turns on, the operating system initializes but fails to
execute commands.

The next set of troubleshooting procedures relate to:

* Memory, expansion enclosure, monitor, and common problems
* Ethernet printer cable faults

¢ Temperature and general power checkouts

* Handling error messages

* Collecting data log files

* Formatting image disks

¢ Disk striping
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4.41 Color Controller C-80 Does Not Turn On

Symptom Recovery Action

Color Controller C- Verify that:

80 does notturnon. | , The power cables are properly connected to the Color
Controller C-80

* The electrical outlet functions properly

* The power-on LED is illuminated

* There are no short circuits between the system board
and the chassis

* The memory DIMMs are correctly seated
Then:
1. Turn the power on and off to test the system.

2. The battery on your system board may be old. Verify
that it still supplies ~3 volts DC; if not, replace the
battery.

3. If you just installed an option, remove it and restart
the Color Controller C-80. If it turns on, you might
have installed more options than the power supply
supports.

4. Review General Power Checkout on page 73.

5. If the problem remains, escalate the service call.
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4.4.2 Color Controller C-80 Turns On, No Operating System

In this situation it is not possible to run the JOIND diagnostics software.

Symptom Recovery Action

system does
not initialize.

—_

A 0D

o

The operating | Verify the following:

* The SATAZ2 cables and the power cables are
properly connected.

* The system disk is not damaged physically.

* The boot order is correct.

To verify the boot order:

. Restart the server.

Press DELETE to enter the computer BIOS.
Use the arrow keys to select the Boot menu.

Verify the boot order is the same as shown in step
16 on page 57.

Reload the operating system; see page 39.

6. Replace the system disk.

4.4.3 Color Controller C-80 Does Not Execute Commands

In this situation it is possible to run the JOIND diagnostics software.

Symptom

Recovery Action

The FusionRA board
does not appear when
running diagnostics.

1. Verify that the FusionRA board is correctly
seated.

2. Replace the input memory located on the
FusionRA board.

3. Replace the FusionRA board.

A disk is not
functioning properly.

1. Check that the disk is correctly installed.

2. Verify that each SATA2 cable is connected
to the correct disk and system board
connector.

3. Verify that the voltage cable to each disk is
securely connected.

Several tests fail as a
result of a particular
failure.

When there is a memory failure replace the
Fusion RA board and run tests on the board
again.
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4.4.4 Memory Problems

Symptom Recovery Action
The amount of Verify that:
_memory displayed 1. The memory modules are seated properly.
is less than the
amount of memory 2. You installed the correct type of memory (ECC
installed. DDR2 memory, part number
Creo 102-00105).

3. If you changed the memory modules, they are
installed on the system board in DIMMs 1A and
2A. Do not use any other DIMM banks. See
Installing a DIMM on page 102.

4. Check for faulty DIMM modules or slots by
swapping a single module between two slots
and noting the result.

5. Check that the 115/230 V power-supply switch
is correctly set.

6. If the memory tests fail, replace the failing
DIMM.

4.4.5 Monitor Problems
Symptom Recovery Action
The Color Verify that:
Controlller 9' 1. The power cord is plugged into the Color Controller
ilo mkomtor IS C-80 and a working electrical outlet.
ank.

The monitor cables are connected properly,
including the AC adapter.

The monitor is turned on and the brightness and
contrast controls are adjusted correctly.

Connect the monitor to a portable workstation to
check its working status. If the problem persists,
replace the monitor with a confirmed working
monitor. If this monitor works, replace the original
monitor.

If the power is on and there is still no video, remove
all the add-on adapters and cables, and use the
speaker to determine if any beep codes exist. See
POST Beep Codes on page 60.

If the problem persists and the screen remains
blank, contact your support person.
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4.4.6 Common Problems

Symptom

Recovery Action

During installing the
operating system,
you see a blue
screen.

1. Restart the computer.

2. If you just installed an option, remove it and
restart the Color Controller C-80.

An image disk is not
identified.

Check the following:
* The disk cables.

* That the disk is mounted correctly in the disk
bay. If the problem persists, replace the disk.

The system disk

cannot be identified.

1. Check that the power cable and the SATA2
are properly connected to the disk.

2. See the procedure to identify the operating
system in Color Controller C-80 Turns On,
No Operating System on page 69.

The DVD-RW drive
is not identified.

1. Restart the server and press DEL to enter the
BIOS setup utility Setup Utility. See Using
the Phoenix cME FirstBIOS Pro Setup Utility
on page 50.

a. In the Main menu, verify the following
settings:

* Serial ATA is [Enabled]

* Native Mode Operation is
[Serial ATA]

* SATA RAID Enable [Disabled]
* SATA AHCI Enable [Disabled]

2. If the problem persists, check that the SATA
cable and the power cable are firmly situated
in the Color Controller C-80.

3. If the above mentioned items are working,
replace the DVD-RW drive.

The system’s setup
configuration is lost.

The battery on your system board may be old.
Verify that it still supplies approximately 3 volts
DC; if not replace the battery.

If this does not help, escalate the service call.
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4.4.7 Color Controller C-80 to Ethernet Printer Cable Faults

The Color Controller C-80 is connected to your printer with one ethernet printer
cable that carries the following data and configuration details between server and

printer:
* Information on your printer’'s power condition

* CMYK data

Symptom Recovery Action Further Action
(if printing fails)
General 1. Shut down your printer and the Color Controller C- | > If printing fails, refer to
80. the next symptom.
2. Check that the Ethernet printer cable is securely
connected to the Color Controller C-80 port.
3. Start the server.
4. Wait until the Color Controller C-80 splash screen
disappears.
5. Start your printer.
Before you 1. Check if the Print Queue is in Enable mode. » If printing fails with no
pr!nt, the 2. Check if there is no alert message that indicates corr;mun;;:at;g errotr,
prl.nter. that a different paper size or type is required. rep ace the erne
animation printer cable.

shows green
indicating that
the printer is
ready. After
sending the
job, the printer
appears to be
warming up
but does not
print.

N o o &

Check that there is no error message on your
printer’s user interface.

Shut down your printer.

Replace the Ethernet printer cable.
Start your printer.

Send a print job.
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printed output
results appear
with scratches
(white lines) in
one of the
CMYK color
combinations.

Check that the Ethernet printer cable is connected
to the Color Controller C-80 port.

Start the server and wait until the Color Controller
C-80 splash screen disappears.

Start your printer.
Send a print job.

Symptom Recovery Action Further Action

(if printing fails)
No communi- | 1. Restart both your printer and the Color Controller | > [f printing fails with no
cation after C-80 according to the startup procedure. communication error,
following the 2. Send a print job. replace the Ethernet
correct startup printer cable.
procedure.
Job printed 1. Shut down both the Color Controller C-80 and your | If printing fails with color
with one color printer. overlay:
overlay, or

1. Replace the Ethernet
printer cable.

2. If the procedure does
not solve the problem,
it could be a FusionRA
board problem.

4.4.8 General Power Checkout

Power problems can be difficult to troubleshoot. For instance, a short circuit can
exist anywhere on any of the power distribution buses. Usually a short circuit causes
the power subsystem to shut down because of an over-current condition.

A general procedure for troubleshooting power problems is as follows:

1.
2.

Turn off the system and disconnect the AC power cord(s).

Check for loose cables in the power subsystem. Also check for short circuits.

For example, if there is a loose screw causing a short circuit on a circuit board.

Remove adapters and disconnect the cables and power connectors to all

internal and external devices until the system is at the minimum configuration

required for operation.

Reconnect the AC cord and turn on the system. If the system starts
successfully, replace adapters and devices one at a time until the problem is
isolated. If the system does not turn on from the minimal configuration, replace
FRUs of minimal configuration one at a time until the problem is isolated.

4.4.9 Temperature Checkout

Accurate cooling of the system is important for proper operation and system
reliability.
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Confirm the following:
* Each of the drive bays has either a drive or a filler panel installed.
* The cover is in place during normal operation.

* There is at least 50 mm (2 inches) of ventilated space at the sides of the Color
Controller C-80 and 127 mm (5 inches) of space around the front and rear of the
server.

* The cover is removed for no longer than 30 minutes while the server is
operating.

* The fans are operating correctly and the air flow is good.

* A failed fan is replaced within 48 hours.

4.4.10 Error Messages

There are four types of error messages:
* System

* Hardware

* Software

¢ Connection

Each error message indicates a problem and sometimes also a recovery action. If
the problem is not resolved after performing the recovery action, perform a
diagnostics test and replace the problematic part.

The following tables contain examples of different error messages.

System Error Messages

Message Recovery Action
System error. Reboot the 1. Restart the system from the
system. Start menu.

2. If the error message
reappears, run the diagnostics
test.

System error. Reinstall Reinstall the Color Controller C-80
the Color Controller C-80 software, and restart the system.
application.
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Hardware Error Messages

Message

Recovery Action

FusionRA Tload
failure. Reboot
the system.

1. Check that the FusionRA board is seated
correctly and restart the system.

2. Run the diagnostics test.

3. If the error message still appears, replace
the board.

Software Error Messages

Message

Recovery Action

Failed to spool
the file during
Jjob submission

Check the image disk space and free disk
space, if required.

Failed to locate
the thumbnail for
element <name of
element> in the
job <job name>

Repeat the RIP process.

Wrong striping
configuration—
reboot the
computer and
configure the
striping

Re-create striping. See Disk Striping on
page 77.

Connection Error Messages

Message Recovery Action

Ethernet 1. Check the cable connections.
cor.mectw on 2. Restart the client workstation computer
failure

and the Color Controller C-80.

3. Check the communication parameters in
the client workstation computer and the
Color Controller C-80.

4.4.11 Collecting Data Log Files

The data logs collection feature enables you to collect log files from both the Color
Controller C-80 software and system board.

When troubleshooting a problem in the system, you may be requested to recreate
the problem with the data log collection tool enabled and send the trace results to
your service representative.
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Collecting the Data Logs
1. Shut down the Color Controller C-80 software.

2. From the Windows Start menu, select Color Controller C-80 > Color Controller
C-80 Tools > Data Logs Collection.

* Data logs Collection g|

Fleaze make sure the Color Server application iz shut
down. ‘When vou click OK, the System Traces will
open. |n the Color Server workspace, a new window will
appear with a STOP button,

*r'ou need to immediately recreate the problem, and then
click the STOP button.

The traces will then be zaved as a Data_logs.cab in:

|D:\S haredD ata_logs.cab Browse ...

Send the Data_logs.cab file to your
contact person.

(] 8 | Cancel

Saving the Data Logs
1. If you accept the default cab file location, click OK and proceed to step 3.

2. If you want to save the cab file to another location, click Browse, select the new
location, click Save, and then OK.

3. Restart the Color Controller C-80 software.

Stop Collecting Logs g|

Click the: STOP button to close
tracing and stop collecting logs.

Stop

4. Recreate the problem you have encountered and then click the STOP button.

The Color Controller C-80 software closes automatically and the log files are
saved as a Data_logs.cab file in D:\ Shared, or in the location previously
specified in step 2.

Sending the Data Logs

» Send the Data_logs.cab file to your your service representative.
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4.4.12 Disk Striping

Perform disk striping if the Wrong Disk Configuration message appears. This
message may appear in the following instances:

* The operating system does not identify a disk because a cable, such as a
SATAZ2 or power cable, is faulty or not connected properly. See Troubleshooting
on page 67.

* The operating system and the Color Controller C-80 software have been
installed from scratch, and the operating system only recognizes foreign disks.
See Striping Foreign Disks on page 78.

* Animage disk either has been replaced with a new disk, and the operating
system identifies it as an unknown disk. See Striping Unknown Disks on
page 80.

¢ Afaulty image disk has been replaced with a new disk, and the new disk is
intermittenly unavailable. See Removing a Missing Disk on page 82.

Note: Ifthe Image Disks File System is not Formatted message
appears, proceed to step 2 of the Confirming the Disk Striping procedure on
page 85.

To establish the correct disk striping procedure:

1. If the following message appears, click OK.

‘Wrong Disk Configuration,
Run Disk Administrator to Correct,

The Computer Management window appears.

Yew  Wreke  Help
BE fE XS ad

[ YT rep———

T Free | Pt Tekessren | Croarhand
) .

5E
]

T
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2. Perform one of the following tasks:
¢ Stripe the foreign disks— See Striping Foreign Disks on page 78.
¢ Stripe the unknown disks—See Striping Unknown Disks on page 80.
* Remove the missing disk—See Removing a Missing Disk on page 82.

3. After completing disk striping, the following message appears:

Image Disks FileSystem Is Mot Formatted.,
Press Ok To Format,

4. Click OK.

Striping Foreign Disks

Perform the following procedure to remind the operating system that a striped
volume resides within the operating system.

1. In the Computer Management window, verify that the disks you need to stripe
(Disk 1, Disk 2, or Disk 3) are labeled Dynamic.

Bl Fie  Actien  Vew  Widow  Help
- OEPE RXSFFaB

Sl Computer Managemant (Local) Vokane | Layesd | Type | Fis Sisteen | S [ copuacty | Fron Space | % Fren | Fouk Tokeare | Gverbnad
T Sstern Tecks S (c) ewienn wwe WIS skl (ystem) TLO0GH  L1URGH  Sm N .

L Computer Management r:lm&

(L Event Viewar 3 (0:) Puthion Basc NIFS Haskhy HINW ALN@ WE W [
g et Frkders

i W] Local Usees and Groups
48] Parfarmance Logs and At
e

iy o)
L3160 GH 20,00 G NIFS 212 GUNIPS
Mkt {Systen] Heskhy

Srn-somn

2. Right-click in the area where the disk is designated Dynamic, and select Import

Foreign Disks.
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Import Foreign Di

Convert to Basic Disk.
it

Properties

Bas  Help

Ann

Note: Foreign disks are any hard disks that were recognized as dynamic
disks from a previous installation.

Import Foreign Disks

Before uzsing these disks, add them to your spstem configuration.

3. Verify that the Foreign disk group (3 of 3 disks selected) check box is selected
and click OK.
Foreign Disk ¥olumes
The following list shows the type, condition, and size of volumes on these foreign
dizks. Click OK to add these disks.
Type Condition Size
=D Stiped volume QK T1841E .
Ok ] [ Cancel

4. Click OK.

The Dynamic disks are striped, as shown in the following window.
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. Computer Managesent [= [l
Al B aon Yew Wedow oo ===
e BDE #E BXSFaE
B Computer Manspemant (Local) Voo | Loyt | Type | Pl System | b [ Copaty | Froe Space | 3 Frre | Foult Toierancn | Crooshead |
B Svbem Tk =] Strged  Gyraic sty MEASGE MRLESCE D% N e
 (ll Event Viewsr SH(C) Pattion Basc  NIFS Hesthy (Systen) J000GE  1LETGD SN Mo %
i ) Shared Filders S (D) Fatbon Basc  NIFS Heskhy Zl2BGh 210G WR N %
5 A Loca Users and Grougs
i ] Purfarmance Logs and lert:
Eoisk 0
B [(=] [14]
LI 20,00 GRNTFS 2120 GO NTFS
riem sty {Systen) Hesthy
Fgisk 1
Eyrrnic
Fa Y 32 8 8
Crine Hnalty
Soisk 2 |
Dynamic
22,060 2326858
Crie Heskhy
Eoisk 3
Eynanic
TR Zr 0G0
Ordew: sty
Sonomn
END (E:)
Mo Meds
< | I Unalocated [l Frimary parttion [l Srpod vohme

5. Close the Computer Management window.

6. Whenthe Image Disks File System is not Formatted message
appears, click OK.

Striping Unknown Disks

The following procedures describe how to initialize unknown disks to basic disks,
and to convert basic disks to dynamic disks.

Perform the following procedures if you have replaced an image disk.

To initialize the disks:

1. In the Computer Management window, right-click the disk you want to initialize,
and select Initialize Disk.

Initialize Disk

Select one or more disks to initialize.
Disks:

(Wi Disk 1

Disk 2

Disk 3

I 0K I[ Cancel ]

2. Verify that the image disk check boxes are selected, and click OK.
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3. Verify that the Computer Management window appears similar to the following

& Computer Management |
Bl Fle Acton  View  Window  Help =[®] x|
«+ DEEE REFB
Sl Computer Managemant (Local) Vi [ Loveut | Tygee | Fio Siritem | ot [ copuacty | Fron Space | % Fren | Fouk Tokeare | Cverbnad
B Svtern Touis S ic) ewieen wwe WIS Haskhy (Systen) DOCOGH 103G 6O Mo Y
(L Event Viewar 3 (0:) Pathion Basc NIFS Haskhy LN ALWW WE W [
g et Frkders
it W LocaUsers and Groups
- ] Performance Logs and Alert:
Bl D Mariager
5 e
G meereresbin St g
sk Defraguenter
Dk Managerissrk
) (8 Services arad Bpplestions
® F Ehoisk 0
Basx () (3]
L3160 GH 20,00 G NTFS 212 M GUNIFS
Crirw Mty {Systen] Heskhy
Fhnsk 1
e
T T a2 e Gh
Cring sl st
ik 2 | ——
Basc
FEY T 28808
Orine Unslocated
Ehoisk 3
e
TR 25 Gl
Orien sl atnd
SHOn-R0M 0
VD (E:)
Mo Meda
F ¥ | I Unalocaned [l Frimary partion

4. Proceed to Converting the Disks to Dynamic Disks.

Converting the Disks to Dynamic Disks

1. Inthe Computer Management window, right-click in the disk area that you want
to convert and select Convert to Dynamic Disk.

E¥Disk 1 I
Basic
2325 "
fe  Converk ko Dynamic
Properties
ﬁ[h i
Basic Help
232,80 o
Online Unallocated
E¥Disk 3 I
Basic
232,88 GB 232,88 GB
Online Unallocated

2. Select the disks to convert to dynamic disks, and click OK.

Convert to Dynamic Disk

Select one or more basic disks to convert to dynamic disks.
Disks:

[ Disk 0
Disk 1
Disk 2

[ Ok H Cancel ]

Attention: Do not select the disk that is the system disk. Selecting the
system disk will cause all information to be lost.
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3. Verify that the Computer Management window appears similar to the following
window.

. Computer Managesent

Ml Fie Action Ve Wirdow Help =l®]=|
e DEEE REB
S Computer Managenart {Lochl) Vi [ Loveut | Tygee | Fio Siritem | ot | Capacity | Froe Space | % Froe | Fauk Tokwance | Orverbnad
BB Svitemn Texs S ic) ewieen wwe WIS Haskhy (Syste) DOC0GH  1ZAJGH 6O Mo Y
5 {8 Evet Viewer S (0i) Pathion Dasc NIFS Haskhny nIWW DLW HH N 3
g et Frkders
it W LocaUsers and Groups
- ] Performance Logs and Alert:
Bl D Mariager
= [ Sorage
Feerreresbin Stin g
Disk Defragmenter
Dk Managerissrk
) (8 Services arad Bpplestions
® F Ehoisk 0
Basx {c) [14]
Frna 2000 GENTFS 212 M GUNIFS
rdem ety (Systern]) Hestfy
Fhnsk 1
s
For Y a2 R
Crine sl st
ik 2 | —
Dynarmic
220460 28808
Grina s
Ehisk 3
Dk
TR 25 Gl
Ovien sl atnd
Sheo-romn
VD (E:)
Mo Meda
F 3 | W Unalocaned [l Frmar parhon

4. Proceed to Creating a Striped Volume.

Removing a Missing Disk

Perform the following procedure when you have replaced a faulty disk and the new
disk is intermittenly unavailable.

1. Right-click the white area opposite the missing disk and select Delete Volume.

. Computer Managesent
B Fie Adion Vew  Window el =lalx|
e BDE fE BXSFa =
B Computer Manspemant (Local) Voo | Loyt | Type | Pl System | Stabus [ Copaty | Froe Space | 3 Frre | Foult Toierancn | Crooshead |
T Sstem Tecs O ] SUASGH GELASGE 0% Mo ™
(L Event Viewer SH(C) Puttion Basc  NIFS Hesthy (ysten) MOUGH  ILEE WN N %
i ) Shared Filders S (D) Fatbon Basc  NIFS Heskhy 2120860 2LRE WR N %
it W LocaUsers and Groups
- ] Performance Logs and Alert:
Bl D Mariager
= i Soeage
Feerreresbin Stin g
Disk Defragmenter
Dk Managerissrk
) (8 Services arad Bpplestions
» 4 Ehoisk 0
Base (=) (o)
Frna 2000 GENTFS 212 M GUNIFS
Crien ety [Systenn] Heskhy
sk 1
s
Forein
ik 2 I —
Dymamic
220460 22 E80H
Oring Faded
Ehisk 3
Oy
TR 25 G
Ovien el
B i
Eryrumic
I 238808
ofien Faiee)
S -ROM D
VD)
Mo Meds
Delete Vohare...
< | I Unalocated [l Frimary parttion [l Srpod vohme

2. Click Yes.
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Delete striped volume

'E All data on this volumne will be lost,
L

Do you wank ko conkinue?

The missing disk volume is deleted.

3. Right-click the Missing Dynamic area, and select Remove Disk.

QMissing

Creniamic

Offline Reactivate Disk
En-ROM ( i

DYD (E2) Properties

No Media Help

The missing disk is deleted.

4. Proceed to Creating a Striped Volume.

Creating a Striped Volume

After you have replaced a disk, or low-level formatted one or more disks, you need

to create a striped volume.

1. In the Computer Management window, right-click the white area to the right of
the disk for which you need to create a volume, and select New Volume.

2. In the New Volume Wizard, click Next.

New Volume Wizand | ‘

Select Volume Type
Theie are five lpes of volumes: simple. spanned. stiped, mirored. and RaID-5

Select the volume pou want to create:
() Simple
() Spanned
O

[Drescription

A striped volume stores data in stripes on bwo or more dpnamic disks. & stiped

volume gives you Faster access ta your data than a simple or spanned volume.

[ < Back ” Mext >

] [ Cancel

3. Select Striped, and click Next.
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New Yolume Wizand

Select Disks
“fou can select the disks and set the disk size for this volume.

& £

Select the dynamic dizsks you want to use, and then click Add.
Available:

Disk & J38473ME
Disk 3 238473 MB

Selected:

< Remove Al

Total volume size in megabytes [MB]: 238473
M aximum available space in MB: 238473

Select the amount of space in MB: 238473 :

4. Inthe Available list, select each disk that you want to include in the new volume
and click Add.
New Yolume Wizard rg|
Select Disks
“fou can select the disks and set the disk size for this volume. 2
Select the dynamic dizsks you want to use, and then click Add.
Available: Selected:
isk 1
Total volume size in megabytes [MB]: 715419
M aximum available space in MB: 238473
Select the amount of space in MB:
[ < Back ][ Mext > ] [ Cancel
5. Click Next.

New Volume Wizard

Assign Drive Letter or Path

For easier access, you can assign a drive letter or dive path to your vaolume.

() Assign the following drive letter

() Mount in the following empty NTFS folder:

@00 not assign a diive letter or dive patk

[ < Back H Ment > ]I Cancel ]

6. Select Do not assign a drive letter or drive path, and click Next.
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New Volume Wizand EJ

Format Volume
To store data on this volume, you mugt format it first,

Choose whether you want to format this volume, and if g0, what settings you wart ko use.
(©iDa not fomat this volume

() Format this volume with the following setings:

[ < Back ” Mext > ][ Cancel ]

7. Select Do not format this volume, and click Next.

New Yolume Wizand g]

Completing the New Yolume
Wizard

Y'ou have successfully completed the Mew Volume ‘Wizard,

You selected the following settings:

Wolume tppe: Stiped

Disks selected: Disk 1, Disk 2, Digk 3
Wolume size: 715419 MB

Dirive letter or path: Mone

File system: Mone

Allocation unit size: Default

To close this wizard, click Finizh.

< Back " Finizh ][ Cancel

8. Click Finish.
9. Confirm that the disks are striped.

Confirming the Disk Striping

After you complete the New Volume Wizard, the Computer Management window
appears.
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. Computer Managesent
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- OE PE AXSFFaB

) Conpurer Mansgemack (Locall || Vokume | Layeet | Type | Fie Sysbem | Sl Copacly | Froe Spoce | % Froe | Foust Tolerance | Creoehose |
T Sstern Tooks [= = p— ity CHEASGH GWASGE K% Mo .
(4 Event Viewer () Pathion Bas  NIFS Hesthy (Spstanr) SDO0GE  ILEPGD BN Mo e
# g Shared Flders &3 (D) Partkion Basic NTPS Heakhy ZI2A8GD 21130GB W% No %
i W Local Users and Groups
- Perfarmance Logs and Akt

] S —
& sorage
P T —
Dot Defragmenter
o3k Mot

4 8 Services o vk i

» Ehoisk 0
Base (=) (o)
prr ] 20,00 BB NTFS 212 GINIFS
Cridem sk (Systen) Hestty
Fhnsk 1
Oy
T 42 108 G
Crine Hinsty
Eink 2 I
Dymamic
12686 R
Grine sty
Ehoisk 3
Gy
2 G sRmw
rden st
SHOn-R0M 0
oD E:)
o Meda
¢ 5 || I Unstocated I Frmary pariton [l Stped vohme

1. Close the Computer Management window.

When the Image Disks File System is not Formatted message appears,
click OK.

4.4.13 Formatting the Image Disk

Perform the following procedure when suggested as a recovery action.

Important: Formatting erases all data stored in the Storage area. It is
recommended to back up your data, if possible, to an external device or
network.

1. Close all software programs and wait for them to shut down completely.

2. From the Windows Start menu, select Color Controller C-80 > Color Controller
C-80 Tools > Format Image Disks.

E ‘fou must close all opened windows before running Format
L

Press Ok ko Continue, Otherwise Press Cancel

oK |

3. Close all open windows, if required, and click OK.

' E Press Ok To format Image Disk File System,
L

Otherwise Press Cancel

4. Click OK.
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Are you sure ?
Press Yes ko continue,  Otherwise Press No.

\2/- All data From the Storage Folder will be erased.
-

5. Click Yes.

Format Image Disk File System Finished. Please Restart Computer

6. Click OK.

7. To enable the changes to take effect, restart your computer.
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5.1 System Components

Use the following diagram to locate a specific part for replacement. In the Spare
Parts List on page 91, each number in the Iltem number column corresponds to a
spare part—not all the parts in the spare parts list are illustrated.

Figure 7: Spare parts diagram



91

5.2 Spare Parts List

Color Controller C-80 Spare Parts List (FRUs- Field Replaceable Units)

Item Description Creo Part Type Qty/

Number Number Unit

1. Battery, 3V, Lithium, CR2032 210C03010 1

2. PRW Cord,18AWG,BR/BL/ 216-00160 2
GR,3M SJT,USA/C13

3. Power Cord 10A,250V,C-13 216-00161 2
CONN. [LF]

4, Power Cord 10A, 250V, C-13, | 216-00164 2
CON. UK. [LF]

5. Cable 216-00169 1
Ethernet Shielded,CAT5E,10M

6. Cord, Power, 10A/250V, AU & | 216-00973 2
NZ, 2.5M, Black

7. Fan 12V Wiring Assy. (92 X 92) | 220-01391A 2

8. Bracket,Ricoh DFE,Net Cable 252-21224A Creo 1
Protector

9. CAP, Ricoh DFE,Net Cable 252-21226A Creo 1
Protector

10. FusionRA [LF] Board 503-00561B Creo 1

11. Universal Stand Type Il 518-01588A Creo 1

12. CPU Kit Q9400,Quad Core2, 518-03787A 1
2.66GHZ,1333MHZ

13. Kit, Color Controller C-80 front | 518-04033A Option
cover

14. Chassis Screws kit - Color 518-04035A 1
Controller C-80

15. Left cover kit 518-04036A

16. GM Eye-One Pro without UV 600-00051 1
Cut Filter [LF]

17. HD,250GB,7.2KRPM,SATA2 607-00253 4

18. CMPTR, DVD R/W, SATA, 607-00254 1
Black

19. Monitor,LCD 19" Wide,Black 608-00070 1

20. CMPTR, Keyboard and 609-00343 1
Mouse,Basic Pack,Black[LF]

21. Computer Rear Fan (120 X 609-00393 1
120)

22. Computer CPU,INTEL P4 609-00401 1
LGA775,Cool Fan

23. USB2.0 Cable,2-Port W/ 609-00504 1
Bracket,40CM,LF

24. CMPTR,MB,X7SBL-LN2 609-00532 1
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Color Controller C-80 Spare Parts List (FRUs- Field Replaceable Units)

Item Description Creo Part Type Qty/

Number Number Unit

25. Computer,Memory 609-00533 2
Module,1GB,DDR2,ECC,800M
HZ

26. SATA Cable,Straight, Right 609-00564 5
Angle (UP)

27. P/S,ATX,350W,6 SATA 609-00568 Third party 1
Connectors

28. Color Controller C-80 Media 634-00634A Creo 1
Software Kit V1.0
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5.3 Before You Begin

Before you begin to replace parts:

A

Become familiar with the safety and handling guidelines specified in Safety
Information (Multi-Language) on page v. These guidelines will ensure your
safety while working with the Color Controller C-80 and its options.

Ensure that you have an adequate number of properly grounded electrical
outlets for the server, monitor, and any options that you intend to install.

Back up all important data before you make changes to disk drives.
Have a small flat-blade screwdriver available.

Warning: Before performing any hardware maintenance or repair, turn off the
Color Controller C-80 and all peripheral devices. Disconnect all external
cables and power cords.

5.3.1 System Reliability Considerations

To help ensure proper cooling and system reliability, verify that:

The side cover is in place during normal operations.

There is space around the Color Controller C-80 to allow its cooling system to
work properly. Leave about 127 mm (5 in.) of space around the front and rear of

the server.

Cables for optional adapters are routed according to the instructions provided

with the adapters.

A failed fan is replaced as soon as possible, to prevent possible damage to the

boards.
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5.3.2 Hardware Connections

Figure 8 shows the hardware connections for the Color Controller C-80.

Connection Guide

power 24-pin CPU Fan power conn.8pin Header Pins Wire Color
20 19
Ground | | NMI i | we | W-White
Fanf X

X “ | G-Green

Power LED Vee R-Red
-he

HOD LED UID SwitchVee
NICT LED Vee
NICZ LED Vee P-Purple

intel 3200 i Blue_LED _Cathode | OHFan Fail PWR Faill
1 e _ uiDwes | UDLED ! Y-Yellow
PWR Fail LED Vee

B-Black

- O-Orange

NC- Not
Connect

Ground | Reset FP Reset Button
Ground PWR. FP Power Button

DIMM1A
DIMM224

DIMMI1B
DIMMZE

Image 3 D‘r?sku

(it —————"
gaTADE g Image 2 Djsk |
EEAS & o i
BATAL g - T
EATAZH

image 1 Disk |
i @

sys. Disk ‘,;__..H;

rear USB conn.
front USB conn

PCI-E cards area (fusion ra ) fan conn.

fusionCS2 conn.
DIMM slot 1A & 1B
ar fan conn.

382021694

Figure 8: Hardware connections for the Color Controller C-80

5.4 Removing and Placing the Side Cover and Front
Panel

This section describes the procedures used to remove and place the
Color Controller C-80 cover and front panel.

5.4.1 Removing the Side Cover

1. Turn off the Color Controller C-80 and all peripheral devices. Disconnect all
external cables and power cords.

2. If necessary, unlock the side cover.
3. Loosen the two screws that secure the side cover to the rear of the server.

4. Release the side cover by sliding it toward the rear of the server.
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5. Move the side cover outward and away from the server.

Loosen the two screws

Pull handle to release cover,
and slide out of chassis

Figure 9: Removing the side cover

5.4.2 Placing the Side Cover

1.
2.
3.

Verify that the server is off and that all external cables are disconnected.
Clear any cables that might impede returning the side cover.

With the server in the upright position, rest the bottom of the side cover on the
bottom rail of the chassis.

Align the slots in the side cover with the matching tabs in the chassis. Insert the
side cover into the slots.

Slide the side cover toward the front of the server.
Tighten the two screws that secure the side cover to the rear of the server.
Reconnect all external cables and power cords and turn on the server.

Caution: For proper cooling and airflow, replace the side cover before
turning on the server. Operating the server for extended periods (more than
30 minutes) with the side cover removed might damage server components.
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5.4.3 Removing the Front Panel

1. Review System Reliability Considerations on page 93.

2. Turn off the Color Controller C-80 and all peripheral devices. Disconnect all
external cables and power cords.

3. Remove the side cover (see Removing the Side Cover on page 94).

Tip: It is easier to perform this procedure if you place the server on its side on
a table, with the front panel of the tower computer case protruding over the
table edge.

4. |Inside the chassis, lift the two protruding tabs that secure the front panel to the
front of the chassis and move the edge of the front panel slightly away from the
chassis. See step 4 in Figure 10 and Figure 11 on page 97.

5. Using a flat screwdriver, gently pry the four concealed tabs along the edge of
the front panel away from the chassis.

4 Inside the chassis, lift the two protruding tabs.

Pry the edge of the front panel away from the chassis and open
outward.

Figure 10: Removing the front panel
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6.

7.

When the front panel is free, pull it away from the front of the chassis, and then
push it downward to release the concealed tabs along the bottom of the front
panel from the chassis.

Concealed tabs

- - .’ - ‘ -
A5 S NSNS

Protruding tabs

Figure 11: Front panel removed showing protruding and concealed tabs

Remove the front panel and store it in a safe place.

5.4.4 Returning the Front Panel

1.

2.

3.
4.

With the Color Controller C-80 on its side, insert the concealed tabs along the
bottom edge of the front panel into the matching slots in the chassis.

Push the top of the front panel toward the server until the two protruding tabs,
and the concealed tabs along the top edge of the front panel snap into place.

Note: While pushing the front panel into place, be careful not to damage the
USB port. See Figure 11 on page 97.

Return the side cover. See Placing the Side Cover on page 95.

Reconnect all external cables and power cords, and turn on the server.



98

Chapter 5—Hardware and Maintenance Repairs

5.5 Working with Boards (Adapters)

If the diagnostics check (see Chapter 4, Diagnostics and Troubleshooting) indicates
that any unit components need replacing, follow the replacement procedures.

Figure 12 illustrates schematically the external connectivity of the peripherals and
the internal connectivity of the main components of the Color Controller C-80.

Peripherals Moritor
éﬂ Weyboard
Mouse @ T-
k. k. |
[ OnBoard Devices |
= Core2 Duad 2 86GHz, 1333MHz FSE | —=| FusionRA || Empty Slots PCHE x8
= L2=6ME , 2 x 1024MB Memory DDR2 pdiBus
- = Empty Slats PCHE x4
= SATAD SATAZ SATAA
Dual
Parts
Gigahit
Ethemet SATA] o Empty Slotd PCRI3MHz
LANT
To external network
-—————
-— |
LANZ
To Printer

System disk Image1 Image 2
250GE
SATAZ

Image3
250GE
SATAZ

25068 250GE
SATAZ SATAZ

Figure 12: Peripherals and internal connectivity

5.5.1 Visual Inspection

Whenever you replace any component in the unit:

1.

2
3.
4

A

Check that all boards are retained properly in their slots.
Check that the cables are routed properly.

Check the existence of all the fans.

Check that all the disks are locked properly.

WARNING: When you handle static-sensitive devices, take precautions to
avoid damage from static electricity. For details, see Safety Information
(Multi-Language) on page v.

5.5.2 Replacing the FusionRA Board

The FusionRA board simultaneously decompresses and RIPs data for the duration
of ajob. Perform the following procedures to remove and install the FusionRA board.
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[ T=1

FusionRA
board

[ =N I=1N]

=1

Figure 13: FusionRA Board layout
Removing the FusionRA Board

CAUTION: Before opening the unit, ensure that the power is turned off and that
A the unit is disconnected from the AC mains power.

1. Review Safety Information (Multi-Language) on page v.

2. Turn off the Color Controller C-80 and all peripheral devices. Disconnect all
external cables and power cords.

3. Remove the side cover. See Removing and Placing the Side Cover and Front
Panel on page 94.

4. Using a cross-head screwdriver, remove the hexagonal screws that hold the
board at the right and the left of the chassis.

@ C
@ C

;

5. Grip the front-left and right corners of the board between the thumb and
forefingers of each hand and gently slide the board out.
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Figure 14: FusionRA board

Preparing the FusionRA Board

1.

Touch the sides of the new board’s antistatic packet to an unpainted area of the
server chassis, and then remove the new board from the packet.

WARNING: Avoid touching the components and gold-plated connectors on
the adapter.

Place the board, component-side up, on a flat, antistatic surface.

Installing the FusionRA Board

1.

Carefully grasp the board by its top edge or upper corners, and align it with the
expansion slot on the system board.

Press the board firmly into the expansion slot. Verify that the board fits securely
in the expansion slot and is locked in position.

Attention: When you replace a board in the server, ensure that it is
completely and correctly seated in the system board expansion slot before
applying power. Incorrect seating might cause damage to the system board
or any other board.

If you have other options to remove or replace, do so now.

Insert the hexagonal screw that holds the board at the rear of the chassis and
tighten it.

Insert the hexagonal screws that hold the board at the left and right of the
chassis and tighten the screws.

Return the side cover. See Placing the Side Cover on page 95.

Reconnect all external cables and power cords, and turn on the server.
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5.5.3 Replacing System Board Memory Modules

The Color Controller C-80 comes with Dual In-line Memory Modules (DIMMs) that
are installed on the system board in DIMM bank #1A (blue) and DIMM bank #1B
(blue).

Note: Removing or installing DIMMs may change the configuration information in
the server. Therefore, after removing or installing a DIMM, save the new
configuration information by using the BIOS setup utility program. When you
restart the server, the system displays a message indicating that the memory
configuration has changed.
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Figure 15: DIMM module locations

Preparing to Remove a DIMM

Attention: When you handle electrostatic discharge (ESD) sensitive devices,
take precautions to avoid damage from static electricity.

1. Review Safety Information (Multi-Language) on page v.

2. Turn off the Color Controller C-80 and all peripheral devices. Disconnect all
external cables and power cords.

3. Remove the side cover. See Removing the Side Cover on page 94.

4. Verify which DIMM you want to remove. See Figure 16 on page 102.

Removing a DIMM

1. Press down on the two DIMM release tabs so that they rotate outward, releasing
the memory from its seat.

Attention: To avoid breaking the release tabs or damaging the DIMM
connectors, handle the clips gently.

2. Gently pull the DIMM up and out of the server.
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Installing a DIMM

1. Touch the antistatic package containing the new DIMM to any unpainted metal
surface on the server, and then remove the DIMM from the package.

2. Verify that the DIMM release tabs are open.
3. Orient the memory so that the pins align correctly with the tab.

4. Insert the DIMM into the tab by pressing, one at a time, on the edges of the
DIMM. Ensure that you press the DIMM vertically into the tab. See Figure 16.

DDR2 DIMM

Hote: Noteh bamae
should align
with the
receptive point
on the slot

Figure 16: Installing a DIMM

5. Verify that the release tabs are in the closed position. If a gap exists between
the DIMM and the release tabs, the DIMM has not been properly installed. In

this case, open the release tabs, remove the DIMM, and then repeat steps 4
and 5.

6. If you have other options to remove or replace, do so now.
7. Return the side cover. See Placing the Side Cover on page 95.

8. Reconnect all external cables and power cords, and turn on the server.
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5.6 Working With the System Board

This section shows illustrations of the components on the system board, and
procedures for removing and installing the system board.

Note: Itis recommended to perform all the procedures in this section with the
server on its bottom on a table.

5.6.1 System Board Internal Cable Connectors

The following illustration identifies system board connectors for internal cables.

o

et
2
56 28
22 5,
L O
pumlEss
TEER =
=8
B =
2 884
I, ]
I‘.
2 A0 &0
£ g
23] =3
2l
I
o™ T e o LR T oo
= onpoaenosoonaoponasnepan poann i
i | o naans0aanoaasoetaatstdanaaa u
o [ x]
oy
®
FE
% B e e P

)
o = Fen I
& ogo0 o0oaopaopaooconcan O] [i9] )|
e AT D W

b

(e ®

Figure 17: System board internal cable connectors
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5.6.2 System Board External-Port Connectors

The following illustration identifies system board connectors for external devices.

7
O |:| 00 —
e | (-
LAN1 LAN2
0 00000 E j E j
ODOO H {i® ......... l {i® oooooooooo @]
5 4 3 2 1

Figure 18: System board external port connectors

1
2
3
4
5
6
7

LAN2 (Printer)

LAN1 (client network)
VGA port (monitor)
COM1 port (DTP)
USB ports 1/2 (mouse)
Keyboard

Optional mouse port

5.6.3 Removing the System Board

1.
2.

Review Safety Information (Multi-Language) on page v.

Turn off the Color Controller C-80 and peripheral devices. Disconnect all power
cords and external cables.

Remove the side cover. See Removing the Side Cover on page 94.

Note: Itis recommended that you place the server on its side before
continuing this service procedure.

Remove the FusionRA board. See Replacing the FusionRA Board on page 98.

Disconnect all the cables connected to the system board, power supply, fans,
and hard disks.

Remove the CPU. See Replacing the Central Processing Unit (CPU) on
page 109.

Remove the eight system board screws.

Release the system board from the RFI clips by sliding the system board away
from the rear of the server.

Note: Radio Frequency Interference (RFI): A high frequency, cyclic series of
spikes or noise injected onto an electrical line by means of radio wave energy or
by a piece of equipment connected to the line. Exists when either the transmitter or
receiver is carrier operated (has an antenna), causing undesired responses to or
from other electronic equipment or systems.

9.

Lift the system board up and out of the server.
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10. Turn over the system board and remove the metal bracket from the board. Set
aside the bracket to install on the new system board.

5.6.4 Installing a New System Board

Attention: When you handle electrostatic discharge (ESD) sensitive devices,
take precautions to avoid damage from static electricity.

1. Review Safety Information (Multi-Language) on page v.

2. Verify that the Color Controller C-80 is turned off and that all power cords and
external cables are disconnected.

3. Touch the antistatic package containing the new system board to any
unpainted metal surface on the server, then remove the system board from the
package and place it on the worktable.

Note: The new system board includes a new black plastic CPU load plate,
which you can discard.

4. Turn over the system board.
5. Attach the metal bracket to the system board.

Note: The Color Controller C-80 is supplied with a reusable metal bracket
attached to the underside of the system board. The metal bracket is part of the
CPU cooling kit (Creo part number 518-03787A).
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Adhesive tape

Figure 19: Metal bracket

a. Turn over the bracket so that it is face down and align it with the diagram on
the system board.

Figure 20: Diagram of metal bracket

b. When the bracket is properly aligned (the four ends should fit into place over
the holes), gently press the bracket into place.

Figure 21: Metal bracket
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Note: If you are reusing a metal bracket that was attached to a previous
system board, the glue may have weakened and lost some of its
adhesiveness. Therefore, make sure to support the bracket with one
hand when installing the system board to its upright position,

While supporting the bracket with one hand, turn over the system board and
place it on the worktable.

Return the CPU. See Replacing the Central Processing Unit (CPU) on
page 109.

Connect the CPU fan cable to the CPU Fan 6 connector. See Figure 17 on
page 103.

Insert the system board into the chassis, and carefully slip it under the five RFI
clips.

Attention: Do not bend or damage the RFI clips. Make sure that the five RFI
clips make firm contact with the external-port connectors. See Figure 23.

[

10.

11.

12.
13.
14.

Figure 22: RFl-clip positions, internal view

System Board

Figure 23: RFl-clip positions, external view

L0 '
@ 0000 O

Align the system board with the matching hole in each standoff insulator in the
chassis.

Insert the eight screws into the holes. Do not tighten the screws until all the
screws are inserted.

Return the rear fan. See Installing the Rear Fan on page 124.
Return the memory modules. See Installing a DIMM on page 102.

Return the FusionRA board. See Installing the FusionRA Board on page 100.
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15. Reconnect all the cables that you disconnected from the system board, power
supply unit and hard disks.

Note: To assist you in reconnecting the cables to the system board, see the
following table and Figure 17 on page 103.

Table 2: System Board Cable Connections

Cable System Board Connector
Power supply JPW1, JPW2
USB USB 3/4 (J46)

USB 2/3 (J44)

Serial ATA SATA 0 (empty)
SATA 1 (DVD/RW)
SATA 2 (system disk)
SATA 3 (image disk 1)
SATA 4 (image disk 2)
SATA 5 (image disk 3)

Security JL1

CPU fan CPU fan 6

Rear fan Fan 5

Front fan Fan 4

Hard disk fan Fan 3
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Ground

hd

Fower LED
(Black)

HDD LED
(Black)

MICT LED
(Black)

MICZ LED
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CHfFan Fail LED
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GEround
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Feset (Reset hutton)
(Red)

PR (Power buttord
(Green)

Figure 24: Front panel connectors

16. Return the side cover. See Removing the Side Cover on page 94.

17. Reconnect all external cables and power cords, and turn on the server.

5.6.5 Replacing the Central Processing Unit (CPU)

Note: The microprocessor speeds are automatically set for this server so you do
not need to set any microprocessor frequency-selection jumpers or switches.

Preparing to Remove the CPU

Attention: When you handle static-sensitive devices, take precautions to avoid

damage from static electricity.

1.
2.

Review Safety Information (Multi-Language) on page v.

Turn off the Color Controller C-80 and all peripheral devices. Disconnect all
external cables and power cords.

Remove the side cover. See Removing the Side Cover on page 94.

Remove the FusionRA board. See Removing the FusionRA Board on page 99.

Remove the rear fan.

See Removing the Rear Fan on page 123.

Removing the CPU Fan and Heat Sink Assembly

1.

Locate the CPU on the system board.
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Figure 25: CPU system board location
1. Locate and disconnect the CPU fan cable from the CPU Fan6 connector.

2. Release the four spring screws that secure the CPU fan and heat sink
assembly to the system board.

Important: Loosen the screws using the crisscross method. First loosen screws
1and 2, and then screws 3 and 4. Once all four screws are loose, remove them
diagonally, one after the other, in the order previously described, until all four
spring screws have been removed.

‘I 3

t&li |
3. Lift the CPU fan and heat sink assembly up and out of the server.

Removing the Microprocessor
1. Unlock the microprocessor socket.

a. Using your thumb, press the socket lever to release the metal frame from its
locking position.
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Metal frame

Figure 26: Unlocking the microprocessor socket

b. Gently lift the socket lever to open the metal frame.

Figure 27: Opening the metal plate

2. Using your thumb and index finger, carefully grasp the microprocessor by its
north and south center edges and lift it up and out of the server.

North center edge

South center edge

Figure 28: Removing the microprocessor

3. Store the microprocessor in an antistatic package for possible future use.
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Installing the Microprocessor

1. Touch the antistatic package containing the new microprocessor to any
unpainted metal surface on the server, and then remove the microprocessor
from the package.

2. Unlock the microprocessor socket.

a. Press the socket lever down to release the load plate from its locking
position. The load plate covers the microprocessor socket.

Load plate

Socket lever

Figure 29: Microprocessor socket lever

b. Gently lift the socket lever to open the load plate.

Load plate

Figure 30: Opening the load plate
c. Remove the load plate.
3. Locate Pin 1 on the microprocessor socket.

Note: Pin 1 is the corner marked with a triangle.



113

Figure 31: Locating pin 1 on the microprocessor socket

a. Make sure that Pin 1 of the microprocessor socket is located at the left
bottom of the microprocessor housing.

4. Insert the microprocessor into the microprocessor socket.

North center edge

\ South center edge

Figure 32: Aligning the microprocessor
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a. Using your thumb and index finger, hold the microprocessor by its north and
south center edges and align Pin 1 of the microprocessor with Pin 1 of the
microprocessor socket.

b. When aligned, carefully lower the microprocessor straight down to the
socket.

c. With the microprocessor inside the socket, check the four corners of the
microprocessor to make sure that it is properly installed.

Microprocessor in the
microprocessor socket

Socket lever

Figure 33: Checking that the microprocessor is properly installed

5. Using your thumb, gently push the socket lever down and lock it in the hook.

Figure 34: Locking the microprocessor

Installing the CPU Fan and Heat Sink Assembly

1. If applicable, remove the thin layer of protective film from the copper core of the
heat sink.

WARNING: I[f the protective film is not removed from the heat sink, the
microprocessor might overheat.
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2. Position the CPU fan and heat sink assembly in such a way that the fan wires
are close to the microprocessor fan, but do not obstruct other components.

3. Apply thermal grease to the top of the microprocessor.

Thermal grease

Figure 35: Applying thermal grease

4. Align the spring screws holes in the CPU fan and heat sink assembly with their
corresponding holes on the system board. Insert the four spring screws and
tighten.

Important: Make sure to insert and secure the spring screws using the
crisscross method. First insert screws 1 and 2, and lightly secure. Next insert
screws 3 and 4, and lightly secure. Once all four screws are in place, tighten
them diagonally, one after the other, in the order previously described, until
all four screws are tightened.
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Figure 36: Securing the CPU fan and heat sink assembly

5. Connect the CPU fan cable to the CPU Fan 6 connector. See Figure 25 on
page 110.

6. If you have other options to install or remove, do so now.

7. Return the FusionRA board. See Installing the FusionRA Board on page 100.

8. Return the rear fan. See Installing the Rear Fan on page 124.

9. Return the side cover. See Placing the Side Cover on page 95.

10. Reconnect all external cables and power cords, and turn on the server.

5.6.6 Replacing the Battery

A

If you need to replace the battery, use a lithium battery, model number CR2032. To
avoid possible danger, read and comply with the following safety statement.

WARNING: There is a danger of explosion if the battery is replaced incorrectly.

Replace the battery only with the same or equivalent type recommended by the
manufacturer. Dispose of used batteries according to the manufacturer's

instructions.

The battery is located on the system board below slot 5. See Figure 13 on page 99.

Note: After you replace the battery, reconfigure the Color Controller C-80 and
reset the system date and time.

Removing the Battery

1. Follow any special handling and installation instructions supplied with the
replacement battery.

See System Reliability Considerations on page 93.

2. Turn off the Color Controller C-80 and all peripheral devices. Disconnect all
external cables and power cords.
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3. Remove the side cover. See Removing the Side Cover on page 94.
4. Remove the FusionRA board to gain access to the battery.
5. Remove the battery:

a. Use one fingernail to press the top of the battery clip away from the battery.
The battery pops up when released.

b. Use your thumb and index finger to lift the battery from the socket.

c. Ensure that the battery clip is touching the base of the battery socket by
pressing gently on the clip.

=

Figure 37: Removing the battery

Installing the Battery

1. Tilt the battery so that you can insert it into the socket on the side opposite the
battery clip.

2. Press the battery down into the socket until it clicks into place. Ensure that the
battery clip holds the battery securely.

=

Figure 38: Inserting the new battery

3. Return any adapters that you removed.
4. Return the side cover. See Placing the Side Cover on page 95.
5. Reconnect all external cables and power cords, and turn on the server

CAUTION: Replacing the battery may cause the configuration to be modified.
Verify that the computer BIOS is configured by performing the procedures in
Configuring the Computer BIOS on page 53.
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5.7 Replacing the DVD-RW Drive

Perform the following procedures to remove and install the DVD-RW drive.

each side)

Figure 39: Bay1 DVD-RW drive

5.7.1 Removing the DVD-RW Drive

1.
2.

Review Safety Information (Multi-Language) on page v.

Turn off the Color Controller C-80 and peripheral devices. Disconnect all power
cords and external cables.

Remove the side cover. See Removing and Placing the Side Cover and Front
Panel on page 94.

Disconnect the cables connected to the DVD-RW.

Press the retaining tabs that hold the DVD-RW drive, then gently slide the drive
toward the front of the server and remove the drive.

Remove the tab strips from both sides of the DVD-RW drive using a cross-head
screwdriver and retain them for future use.

Tab strip (one on each side)

Figure 40: Tab strips on the DVD-RW drive
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5.7.2 Installing the DVD-RW Drive

1. Install the tab strips to the new DVD-RW drive that you removed from the old
DVD-RW drive. See Figure 40.

2. Slide the DVD-RW drive into the DVD-RW drive cage, making sure that the
drive locks into place.

3. Reconnect the cables to the DVD-RW drive.
4. Return the side cover. See Placing the Side Cover on page 95.

5. Reconnect all external cables and power cords, and turn on the server.

5.8 Replacing a Hard Disk

The tasks that you must perform before and after you remove a hard disk and install
a new one differ for the system disk and image disks. The tables in this section
describe the procedure for each case, and tell you where to find the information.

Table 3: Tasks to replace system disk

Step Section in this book

See Color Controller C-80, Powered
by Creo Color Server Technology,
for Pro C900 User Guide (731-

1. Back up the system configuration
(Preferences window)

01699A-EN
2. Replace the disk page 119
3. Reinstall DVD 1 and DVD 2 on [page 39

the Color Controller C-80

4. Restore the system configuration
(Preferences window)

See Color Controller C-80, Powered
by Creo Color Server Technology,
for Pro C900 User Guide (731-
01699A-EN

Table 4: Tasks to replace image disk

Step Section in this book
1. Replace the disk page 119

2. Perform disk striping page 77

3. Format the image disk page 86

Attention:

System disk: Before replacing or formatting the system disk, ensure that you have
made a note of the computer name, TCP/IP information (for example DHCP =
Yes), and OEM Windows XP Professional Product ID#. Back up folders or jobs in
C and D partitions to an external device or network.

Image disks: Before replacing an image disk, ensure that you back up all jobs
(such as: PostScript, High-Res, Variable Print Specification, and PDF jobs) to

an external device or network.



120

Chapter 5—Hardware and Maintenance Repairs

5.8.1 Removing a Hard Disk

1.

Turn off the Color Controller C-80 and all peripheral devices. Disconnect all
external cables and AC power cords.

Remove the side cover. See Removing the Side Cover on page 94.

Tip: You may find it easier to work if you lay the server on its side.

Disconnect the SATA2, data, fan, and power cables from all the hard disks.

Loosen the four screws that secure the drive cage to the server chassis.
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Slide the drive cage out of the server.
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Figure 41: Removing a hard disk drive
Identify which hard disk you want to remove.

Loosen the two screws on either side of the disk drive and pull the disk drive out
of the chassis.

5.8.2 Installing a Hard Disk

1.
2.
3.

Slide the hard disk into the drive cage.
Insert the four screws that secure the hard disk to the drive cage, and tighten.

Insert the drive cage inside the chassis, and over the locating tabs in the front
wall of the chassis.

Align the holes in the drive cage with the matching holes in the chassis.

Tighten the four drive-cage screws and tighten.
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6. Connect the SATAZ2 cables into the back of each drive. Make sure that the
other end of each cable is connected to the appropriate connector on the
system board.

&
cof

Fan 3

a 996000
. Oooaa w

oo DVD R/W
B — l—
= System disk

7Image disks

Figure 42: SATA2 connectors on the system board
7. Route each cable so that it does not block the air flow to the rear of the drives.

8. Connect a power cable to the back of each drive. The connectors are keyed
and can be inserted only one way.

Note: Do not route the cables over the microprocessor and memory.

9. Connect the hard disk fan to the system board (Fan 3).
10. If you have other options to remove or replace, do so now.
11. Return the side cover. See Placing the Side Cover on page 95.

12. Reconnect all external cables and power cords, and turn on the server.

5.9 Replacing the Power Supply

Perform the following procedures to replace the power supply.

Tip: ltis easier to perform the following procedures if the server is on its side.

5.9.1 Removing the Power Supply

1. Review Safety Information (Multi-Language) on page v.

2. Turn off the Color Controller C-80 and peripheral devices.

3. Disconnect all AC power cords and external cables.

4. Remove the side cover. See Removing the Side Cover on page 94.
5

Disconnect the power supply cables to the drives, and to the system board
(JPW1, JPW2).

6. Remove the four screws that secure the power supply to the server from the
rear of the server, using one hand to hold the power supply inside the server.
See Figure 43 on page 122.
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7. Gently move the power supply out of the server.

Figure 43: Removing the power supply unit

5.9.2 Installing the Power Supply

1. Orient the power supply and place it into the server.

2. Insert the power supply into the opening at the rear of the chassis.
3. Align the holes in the power supply with the holes in the chassis.
4. Insert the four power-supply screws, and tighten them.
5

Reconnect the internal cables from the power supply to the system board and
drives.

o

Return the side cover. See Placing the Side Cover on page 95.

7. Reconnect all external cables and AC power cords, and turn on the server.
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5.10 Replacing Fans

Perform the following procedures to remove and install the rear fan and PCI fan.

Connector Fan5

(Rear fan)

il
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Connector Fan4

Figure 44: Rear and PCI fan connector locations

5.10.1 Removing the Rear Fan

1. Review Safety Information (Multi-Language) on page v.

———PCl fan)

2. Turn off the Color Controller C-80 and peripheral devices. Disconnect all AC

power cords and external cables.

3. Remove the side cover. See Removing the Side Cover on page 94.

4. Disconnect the fan cable from the system board connector (Fan 5).

5. Press the two locking tabs, protruding through the outside of the rear of the

server, outward. See Figure 45 on page 124.

6. Lift the fan upward and out of the server.
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Remove the four screws that secure the fan to the rear-fan bracket. See
Figure 45 on page 124.

Apply pressure to the tabs
to remove the fan

Figure 45: Rear fan

5.10.2 Installing the Rear Fan

1.

Align the four holes in the new fan with the matching holes in the
rear-fan bracket, then insert the four screws and tighten them.

Place the rear fan in position at the rear of the server.

Guide the two locking tabs through the top of the slots, while aligning the other
four tabs with their respective slots.

Press the rear-fan bracket against the rear of the server, until all the tabs are in
their slots, and then move the rear-fan bracket downward until it locks into
position.

Reconnect the fan cable to the system board.
Return the side cover. See Placing the Side Cover on page 95.

Reconnect all external cables and power cords, and turn on the server.

5.10.3 Removing the PCI Fan

1.
2.

Review Safety Information (Multi-Language) on page v.

Turn off the Color Controller C-80 and peripheral devices. Disconnect all AC
power cords and external cables.

Remove the side cover. See Removing the Side Cover on page 94.
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Disconnect the fan cable from the system board connector (Fan 4).

Press the two locking tabs, protruding through the outside of the rear of the
server, outward.

Lift the fan upward and out of the server.

Remove the fan bracket and retain for future use.

5.10.4 Installing the PCI Fan

1.

2
3.
4

o

Place the fan bracket on the new PCI fan.
Place the PCI fan in position in the front of the server.
Guide the two locking tabs through the top of the slots.

Press the fan bracket against the rear of the server, until all the tabs are in their
slots, then move the fan bracket downward until it locks into position.

Reconnect the fan cable to the system board.
Return the side cover. See Placing the Side Cover on page 95.

Reconnect all external cables and AC power cords, and turn on the server.
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A.1 Environmental Requirements
This chapter lists the software installation steps, includes specifications for the Color
Controller C-80 operating environment, and provides a list of the international safety
standards to which the Color Controller C-80 conforms.

A.2 Installation Steps

¢ Software installation—time: approximately 30 minutes
* Fullinstallation, operating and software—time: approximately 1.5 hours

¢ System loading—time: approximately 15 minutes

A.3 Specifications

A.3.1 Dimensions and Weight

Color ControllerC-80 | DxWxH (cm) |DxWxH (in.) Weight

Unpacked 58.8 x 20 x 44 23.1 x7.9 x17.3 16.8 kg/37 Ib.

Packed 63 x 78.5 x 46 | 24.8 x 30.9 x 18.1 | 33.1 kg/72.9 Ib.
WARNING:

* The Color Controller C-80 is heavy, and must be lifted by two people.

* Each person must place both hands underneath the Color Controller C-80

from the sides.

Spectrophotometer D xW x H (cm) D xW x H (in.) Weight

(i1)

[Optional]

Unpacked 10 x 4 x5 4 x1 %2 0.8 kg/1.8 Ib.
Packed 46 x 35 x 16 18 x 14 x 6 3.0 kg/6.6 Ib.
Monitor 19" D xW x H (cm) D xW x H (in.) Weight
Unpacked 44 x 19 x 38 17x7x15 4 kg/8.8 Ib.
Packed 51x35x 11 20x18x 4 4 kg/8.8 Ib.
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Keyboard DxW x H (cm) D xW x H (in.) Weight
Unpacked 44 x17%3 17 x 7 x 2 1 kg/2.2 Ib.
Packed 55 x21 x4 21 x 8 x2 1 kg/2.2 Ib.
Stand (Contents D xW x H (cm) D x W x H (in.) Weight

and Carton)

[Optional]

Unpacked 77.2 x 66.8 x102.4 | 30.4 x 26.3 x 40.3 | 28 kg/61.7 Ib.
Stand (Contents LxW x H (cm) L xW x H (in.) Weight

and Carton)

[Optional]

Packed+Pallet 114 x 82.6 x38 44.9 x32.5%x15 45 kg/99.2 Ib.

A.4 Operating Environment

A.4.1 Electrical (Color Server and Monitor)

Input Voltage Range

100-127/200-240 VAC

Input Frequency Range

60 /50 Hz

Ampere Rating

225/1.25A

A.4.2 Energy Consumption

e 220 VAC-1.25 AAC => 275 W =939 BTU/hour
* 110 VAC-2.25 AAC = > 247.5 W = 845 BTU/hour

A.4.3 Transportability

* There is no need for special tools for system transportation.

* The system is without wheels.
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A.4.4 Temperature and Relative Humidity

Items complying with IEC 721-3-1, 2, 3

Temperature Operating 15°Cto40° C
(59° F to 104° F)
Storage -25°Cto70°C
(=77°F to 158° F)
Relative humidity Operating 5% to 85%
Storage Max 95% @ 50° C (122° F)
Items complying with IEC 721-3-0,1, 2, 3
Vibration Shipping Acceleration spectral density of

1m?/s3 in frequency range of
10-200 Hz and acceleration
spectral density of 0.3 m2/secd
in frequency range of

200-2000 Hz.
Free fall Shipping 0.25m
Static load Shipping 10 Kpa
Stacking Shipping 3 boxes

A.5 Standards

A.5.1 Safety Approvals

United States and cCSAus marking for the US and Canada.

Canada Standards: UL 60950-1 2nd Edition, CAN/CSA -
C22.2 No. 60950-1-07

European Union EU Low Voltage Directive 2006/95/EC, standard
EN60950-1:2006

CB Countries CB Report & Certificate according to standards

IEC 60950-1:2005 (2nd Edition) and EN 60950-
1:2006 and National differences: EU Group
Differences; EU Special National Conditions; EU
A-Deviations; CA, KR, US

The CB reports have supplements that together include the national differences for
the following countries:

Australia Portugal
Austria Russian
Federation
Denmark Slovenia
Finland Sweden
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France Switzerland

Germany United Kingdom

Greece

Italy

Japan

Korea

Netherlands

Norway

Poland

A.5.2 EMC Requirements
United States FCC 47CFR part 15: 2008, subpart B
class B
Canada ICES-003: 2004 issue 4, class B
Japan VCCI V-3/2008.04, class B
Australia and New Zealand CISPR 22: 2006, class B
Europe EMC Directive 89/336/EEC
European EMC standards
Radiated Emissions EN55022:2006+A1:2007 Class B
Harmonics EN61000-3-2:2006
Flicker EN61000-3-3:1995+ A1:2001 & A2:
2005

Immunity STD EN55024:1998+A1:2001+A2:2003
Immunity to Electro Static EN61000-4-2: 1995+A1(98)+A2(01)
Discharge
Immunity to Radiated Electro | EN61000-4-3: 2002 +A1(02)
Magnetic field
Immunity to Fast transients EN61000-4-4: 2004
Immunity to Voltage Surges EN61000-4-5: 1995+ A1(01)
Immunity to radio frequency EN61000-4-6: 1996 +A1(01)
Conducted Disturbances
Immunity to power frequency | EN61000-4-8: 1993 +A1(01)
Magnetic Fields
Immunity to supply Voltage EN61000-4-11: 2004
Dips, and Variations

A.6 Reliability and Maintenance

Prediction of Mean Time Between Failure (MTBF) is based on Parts Stress method
of B33216; parts stress method of Bellcore TR-NWT-332Issueb (12/97). The
prediction was performed with CARE software from BQR Israel.
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Environment: GB Ambient temperature: 40° C (104° F).

A.6.1 General Maintenance Information

MTBF Calculation Results MTBF (hours)
CMPTR, MONITOR, LCD 19" 58,080
WIDE, BLACK

CMPTR, KBD+MOUSE, BASIC 58,066
PACK, BLACK]ILF]

FUSIONRA [LF] BRD ASSY 4,591,368
FusionRA board assembly 94,080
CMPTR, HD, 250GB, 7.2KRPM, 2,742,980
SATA2

CMPTR, DVD R/W SATA BLACK |161,290
CMPTR, CPU, INTEL P4 LGA775, |34,998
COOL FAN

CMPTR, MB, X7SBL-LN2 154,641
CMPTR, MEM MODULE, 1GB, 4,887,586
DDR2, ECC, 800MHZ

UP, Q9400, QUAD CORE2, 90,909
2.66GHZz, 6M, 1333MHZ

CMPTR, REAR FAN, 120X120X25, |27,998
98CFM, 12vDC

FAN, AXIAL, 12V DC, 92*92*25, 42 {34,998
CFM+TACH

CMPTR CASE, 65-SLVR, NON 15,550
HOTSWAP DSK + P/S

FAN 12V WIRING ASSY .[LF] 34,975
General Maintenance Information

Periodic call-on None
Failure-recovery period 1.5 hours

Space required for service

2.0 x 1.8 meters (6.7 x 6 feet)

Service tools

* Screwdriver (flat and Phillips)
* Antistatic kit

* Side cutters

* DVM

Typical Space Required for Installati

on

Desktop position

1200 x 1200 mm (47.2 x 47.2'in.)

Stand position

800 x 800 mm (31.5x 31.51in.)
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